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Ordering Terms & Conditions 

By using the Site (http://candlescanner.com) or by placing an order through the Site, or by placing an order through any other medium for products 
described or made available through the Site, you agree as follows: 

1. Order Modification, Cancellation and Refunds 

You agree that all orders placed through the Site, by telephone, by FAX, by electronic mail, by conventional mail or by any other medium are considered 
to have been processed at such time as they are received and accepted by LEMPART. Once your order has been processed, it may not be modified or 
cancelled in any way, for any reason. 

You undertake that, having placed an order, you have ensured that all the information provided to LEMPART in conjunction with your order is accurate 
and correct. You further undertake that you are the person or entity identified as the intended recipient of the product or products being ordered, or 
that you are acting on behalf of the person or entity so identified with the full authority of the person or entity to enter into the transaction which 
constitutes your order. 

You undertake that you have fully evaluated the current evaluation versions of the software products you are ordering, and that you have found them to 
be entirely suitable for your applications, and free of “bugs” or other limitations which would render the software products unsuitable for use in your 
applications. 

You agree that you will make no effort to withhold payment for your order or to subsequently dispute payment for your order, subject to the laws of the 
jurisdiction where you reside. 

You agree that in the event LEMPART does not receive complete payment by credit card for your order due to a dispute, insufficient funds or any other 
cause, LEMPART shall have recourse to seek payment in any manner it sees fit, subject to the laws of the jurisdiction where you reside. Further, in this 
eventuality, you agree to pay, in addition to the total value of your order, any reasonable cost of collection required to obtain payment for your order by 
LEMPART or its agents or representatives. 

You agree, in the case of software products which are to be delivered by downloading, that you have sufficient expertise to effect the download using 
the download facilities provided by LEMPART. The responsibility for successfully acquiring downloadable products is wholly yours. You further agree 
that your inability to download the software you have purchased does not constitute sufficient grounds for the cancellation of said order, or for dispute 
of the charges for said order or any products therein. 

You agree that successful using of the software may require that your computer is constantly connected to the internet. 

You agree that non-delivery of your order does not constitute sufficient grounds for cancellation of said order, or for dispute of the charges for said 
order or any products therein. In the event that your order is not delivered within the time specified by LEMPART at the Site, you agree to contact 
LEMPART and arrange to have a replacement order shipped or provided by electronic media, the medium of the replacement order to be identical to 
the medium of the original order. You agree that the sole responsibility of LEMPART is the replacement of your order. You agree to indemnify, hold 
harmless, and defend LEMPART and its suppliers from and against any claims or lawsuits, including attorney’s fees, that arise or result from the non-
delivery of your order. 

In the event that your order is found to have been undelivered due to an error in the information provided by you to LEMPART for the purpose of 
shipping your order, you agree to compensate LEMPART for the cost of a replacement order, including but not exclusive to packaging, media costs, 
labor and postage or shipping costs, if so requested by LEMPART. 

2. License 

You agree that LEMPART software is licensed, not sold. All ownership, title and intellectual property rights in and to the software accompanying your 
order, including any associated media and any documentation or printed materials, are owned by LEMPART or its suppliers. 

You agree that in ordering software products from LEMPART, you are purchasing a license or licenses to use the software products, subject to the 
specific license terms of the software products. Said licenses pertain only to the version and revision level of the software products current at the time 
the licenses are conveyed, and do not extend to future releases or updates of the software products. 

You agree that the licenses for the software products you have ordered are deemed to be conveyed at such time as your order for the software products 
is processed and accepted by LEMPART. 

You agree that upon receipt of the software products, licenses or registration codes for the software products you have ordered, by electronic or physical 
media, whichever occurs first, you are deemed to have received in full the licenses for which you have paid. 

You agree that licenses for LEMPART software products may not be transferred, exchanged, distributed or resold to persons or entities other than the 
persons or entities placing this order or upon whose behalf this order has been placed without the express written permission of LEMPART. 

You agree that LEMPART shall have the right to terminate your license and your use of licensed products owned by LEMPART at such time as a breach 
of this agreement or of the specific license agreements for the software products is discovered by LEMPART, brought to your attention in writing and 
which remains unresolved for a period in excess of thirty (30) calendar days beyond the date upon which you are notified of said breach. Upon termination 
of your license, you will undertake to delete and destroy all licensed materials, copies thereof and registration codes provided to you by LEMPART. 
LEMPART shall not be required to provide you with redress, compensation, replacement or refund in the event of the termination of your product 
licenses as the result of an agreement breach. 

 

http://candlescanner.com/
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3. Warrantee 

You understand and agree that LEMPART makes no warrantee as to the functionality or suitability of its software products. You agree to accept sole 
and complete responsibility for any loss, damage or expense caused to you or to third parties as a result of your use of the software, and to indemnify, 
hold harmless, and defend LEMPART and its suppliers from and against any claims or lawsuits, including attorney's fees, that arise or result from the 
use of any LEMPART software products. 

You agree that LEMPART sole responsibility in the event that the software products you have licensed prove to be defective in the future is the attention 
of LEMPART to said defects to the best of its abilities, and that you are not entitled to redress or compensation should the remedy of said defects prove 
to be beyond the capabilities of LEMPART or its suppliers. 

You agree that LEMPART does not undertake to support the software products you have licensed, and payment for the software does not include 
payment for support of any kind. LEMPART may at its discretion provide you with support services related to the software. 

4. Privacy and Security 

LEMPART undertakes to take all reasonable precautions to ensure the privacy of information provided to it by you for the purpose of placing an order 
or otherwise licensing or purchasing LEMPART products, and for subsequent communications concerning your order, the products you have ordered 
or related matters. These precautions include but are not exclusive to: 

Your name, address, telephone number, credit card information and e-mail address will not be disclosed to third parties without your express permission 
or proper legal due process, except as is required to facilitate the processing of your order or subsequent related communications. 

You undertake that you will keep in confidence any information provided by LEMPART to you, subject only to proper legal due process. You will not 
disclose to third parties any communication from LEMPART to you without the express written permission of LEMPART. 

You undertake that software product registration codes constitute confidential information provided to you by LEMPART, and you undertake that you 
will not communicate them to third parties except as is required to install the licensed software in accordance with the terms under which it is purchased. 
You will not store, record, transmit or communicate registration codes in an insecure manner, as would permit them to become known to parties which 
have not entered into the license agreement for the software. 

You undertake that intellectual property owned or distributed by LEMPART and its suppliers, including but not exclusive to the text of books, images 
and recorded sound, constitute confidential information provided to you by LEMPART, and that you will not communicate, distribute or disclose this 
information to third parties or store it in a manner likely to allow it to be disclosed to third parties except under conditions permitted in the specific 
license agreements for said intellectual property. In the absence of specific agreements permitting the disclosure of this material, said intellectual property 
shall be deemed confidential. 

You undertake that in the event that your order proves to be in any way fraudulent, or that you violate any terms of this agreement or the license terms 
of the products which you license or purchase, or that you attempt to disavow or dispute all or part of the purchase price for your order, LEMPART 
shall be free to disclose any and all information provided by you in any manner it sees fit. 

You agree that LEMPART is not responsible for errors, acts of third parties or acts of God which may result in the unintentional disclosure of your 
private information. You agree to indemnify, hold harmless, and defend LEMPART and its suppliers from and against any claims or lawsuits, including 
attorney's fees, that arise or result from the unintentional disclosure of your private information. 

5. Activation 

During activation, the software will send information about the software and your computer to LEMPART. This information includes the version, 
license version, language, and product key of the software, the Internet protocol address of the computer, and information derived from the hardware 
configuration of the computer. 

Some changes to your computer components or the software may require re-activation of the software. 

During online activation, if the licensing or activation functions of the software are found to be counterfeit or improperly licensed, activation will fail. 
The software will notify you if the installed copy of the software is improperly licensed. In addition, you will receive reminders to obtain a properly 
licensed copy of the software. 

6. Internet-Based Features (Privacy) 

Features in the software automatically send LEMPART information about your hardware and how you use this software. We do not use this information 
to identify or contact you. This helps us collect information about problems that you have while using the software. 

Features in the software can retrieve online content from LEMPART and provide it to you. Certain features may also permit you to search for and access 
information online. Examples of these features include Patterns Dictionary. This information is used to provide you with content you request and to 
improve our services. You may choose not to use these online features and content. 

7. Your Representation 

You represent and warrant for the benefit of LEMPART that: (a) you are at least 18 years of age; (b) you possess the legal right and ability to enter into 
this Agreement and make the credit card charges on your own behalf or on behalf of any person or entity for whom you are acting as agent; and (c) all 
information that you submit to us is true, accurate and current. 

You represent that, in the event that you provide LEMPART with a physical address to which products are to be shipped, said address constitutes a 
secure and suitable location to which your order can be delivered and accepted by you or someone acting on your behalf. You agree that LEMPART 
will not be responsible for the loss of your order after it has been delivered to the address you have provided. You further agree that LEMPART will 
not be responsible for the unintentional disclosure of your private information after it has been consigned to any third party carrier, including the public 
mails. 
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8. Electronic Communication 

By placing an order with LEMPART, you permit us to communicate with you through electronic media such as e-mail for the purpose of fulfilling and 
subsequently servicing your order. You agree and understand that electronic communication is not infallible, and that if all or part of the license or license 
requirements for your ordered products are to be delivered by electronic media and fail to be received by you, LEMPART' sole responsibility will be to 
retransmit the aforementioned material by electronic media. You agree to indemnify, hold harmless, and defend LEMPART and its suppliers from and 
against any claims or lawsuits, including attorney's fees, that arise or result from the failure of the aforementioned material to be successfully transmitted 
to you by electronic media. 

9. Submission of Ideas, Suggestions or other Intellectual Property 

Any comments or information that you provide to LEMPART, for example feedback or ideas, suggestions, concepts, or other information (collectively, 
the "Submissions"), shall be deemed, and shall remain, the property of LEMPART. None of the Submissions shall be subject to any obligation of 
confidence on the part of LEMPART, and LEMPART shall not be liable for any use or disclosure (including publication in any medium) of any 
Submissions. Without limitation of the foregoing, LEMPART shall exclusively own all now known or hereafter existing rights to the Submissions of 
every kind and nature and shall be entitled to unrestricted use of the Submissions for any purpose, commercial or otherwise, without compensation to 
the provider of the Submissions. 

10. Availability of Ordered Products 

All items ordered from LEMPART are subject to availability. We reserve the right to reject any and all orders. Subject to applicable law, LEMPART 
reserves the right to deliver items acquired as part of your order at different times in the event that they are not available for shipment at the same time. 
LEMPART also reserves the right to limit the quantity of any items that may be obtained by you through the Site. 

All orders placed through the Site are shipment contracts, not destination contracts. If you would like your items delivered at a particular location, you 
will be responsible for the shipping charges. Shipping and handling charges may or may not reflect actual costs and may be amended by LEMPART 
from time to time. 

11. License to Use the Site 

We hereby grant you the right to view and use the Site for the purpose of shopping in accordance with this Agreement. You may download and print 
copies of this document and of screens from this Site for the purpose of retaining records of your transactions at the Site. Subject to applicable law, 
LEMPART reserves the right to suspend or deny, at its sole discretion, your access to all or any portion of the Site with or without notice. 

12. Jurisdiction 

This Agreement is governed by the laws of Poland. Each of the parties hereto irrevocably attorns to the jurisdiction of the courts of the Poland and 
further agrees to commence any litigation which may arise hereunder in the courts located in Poland. 

13. Entire Agreement 

If any part of this Agreement is determined to be invalid or unenforceable, then the invalid or unenforceable provision will be deemed superseded by a 
valid, enforceable provision that most closely matches the intent of the original provision, and the remainder of the Agreement shall continue in effect. 
The Agreement (including any related consents or agreements that you provide during your visit to the Site) together with any license or agreement with 
LEMPART delivered in connection with any item acquired via the Site, constitutes the entire agreement between you and LEMPART with respect to 
the Site and that item, and supersedes all other (prior or contemporaneous) communications and proposals, whether electronic, oral or written, between 
you and LEMPART regarding the Site and/or any order you place through it. 

 

THIS AGREEMENT MAY BE AMENDED FROM TIME-TO-TIME AT THE SOLE DISCRETION OF COMPANY. USER SHALL BE 
PROVIDED WITH TEN (10) DAYS ADVANCE NOTICE BY EMAIL OF ANY SUCH AMENDMENTS AND SHALL HAVE THE 
OPPORTUNITY TO REFUSE SAID AMENDMENTS SOLELY BY REQUESTING TERMINATION OF ACCESS TO THE SOFTWARE. 
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1 Introduction 

CandleScanner™ is a technical analysis software package created for investors interested in Japanese candle patterns. What 
makes this application exceptional is that, from the outset, it has been specifically designed for the detection of Japanese 
candle patterns. It is not just an add-on to an existing analysis platform, but a specialist charting application written by 
people with an extensive knowledge of the topic of Japanese candlestick patterns. It is suitable for both seasoned traders 
and complete beginners. 

Japanese candle patterns are well known and routinely implemented in displaying price behaviour. However, when 
apparent emerging patterns are analysed and discussed, it is frequently the case that the conclusions are imprecise, and, 
indeed, often result in contradictory interpretations of what the patterns are actually saying. Hence, to accurately implement 
a tool scanning charts for candle patterns is not a straightforward undertaking. 

Candle patterns are very interesting for traders due to their simplicity, elegance and natural interpretation of market 
sentiment. No matter how markets evolve, ‘patterns’ will appear on the charts. Essentially, the core premise, and 
assumption, underlying the application of technical analysis is that such patterns are repetitive and detectable. Technical 
analysis is widely employed in various financial markets, informing traders about the non-fundamental determinants of 
price, in other words, "market sentiment."  

However, observing an apparent repeating pattern on a chart can result in completely different trading outcomes. 
Experienced traders know that the efficiency of an investment decision depends not only on the analytical tool(s) employed, 
but also on other factors, such as risk and position management. In this regard, CandleScanner™ can be implemented as 
an objective tool aiding the trader in taking positions, based on the systematic evaluation of price behaviour. 

Trying to identify patterns manually, or visually, by merely scanning the charts can be problematic. It can be also be 
dangerous, as there may be a tendency to see patterns, where there are none, in random data. For example, the very 
successful trader, William Eckhardt, in the Jack Schwager book “The New Market Wizards”, says that we as human beings 
don’t look at data neutrally. That is, when the human eye scans a chart it doesn’t give all the data points equal weight. 
Instead, there is a tendency to focus on certain 'outstanding' cases, and to form opinions on the basis of these special cases. 
That’s why when Eckhardt has an insight based on a chart pattern, he tries to reduce it to an algorithm that can be tested 
on a computer. In order to investigate whether or not the insight has any value, it should be explicitly formulated, tested 
and evaluated. In this regard, an objective assessment has a lower chance of being biased, which is crucial when making 
trading decisions. 

The application of CandleScanner™ is extremely versatile, and can be used by a whole spectrum of traders involved in, 
for example, stock market trading, commodities markets, futures markets or forex. Also, those who are just beginners will 
find CandleScanner™ a great learning and training tool, where they can learn from real-life data-based examples, rather 
than just pure text book theory. 

So, what can the CandleScanner™ application achieve? 

With the application, you can do the following: 

 Quickly scan candlestick charts to find all occurrences of candle patterns 

 Measure the efficiency of patterns, i.e. are they working as you expect them to? 

 Build trading strategies based on candle patterns and simulate transactions (backtesting) 

CandleScanner™ is highly configurable, meaning that you can adjust it to your specific needs. The algorithms scanning 
the candlesticks charts have many parameters, which can be set by the user. Also, the visual aspects of the application are 
highly customizable, enabling everyone to find their desired optimal settings. 

Please check out the Facebook site (http://facebook.com/CandleScanner)or our website http://candlescanner.com for 
further discussion of CandleScanner’s capabilities, candlestick analyses, featured articles, the interpretation of candlesticks 
patterns, backtest results and more. 

Finally, recalling Warren Buffet's (alleged) reflection on the markets: “I'd be a bum in the street with a tin cup if the markets were 
efficient.” CandleScanner can help you exploit such inefficiencies. 

http://facebook.com/CandleScanner
http://candlescanner.com/
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1.1 Technical support 

When you purchase the CandleScanner license, you are entitled to free support. To obtain help, please use the following 
email address: contact@candlescanner.com. 

Typically our response time is less than 12 hours and does not exceed 72 hours (including weekends and holidays). Mostly 
technical issues are fixed within 10 working days (i.e. time to release a bug fix) but we reserve the right to exceed this 
period on occasions. During this period, you are informed about the estimated time and current progress on the issue. 

1.2 Editions of CandleScanner 

Currently as of this writing there are three editions of CandleScanner available: 

 CandleScanner Basic 

 CandleScanner Standard 

 CandleScanner Professional 

The following table summarizes differences between CandleScanner editions. 

 

Feature Basic Standard Professional 

End-of-day (EOD) charting & automatic patterns scanning Yes Yes Yes 

Intraday (n minutes, n hours) charting & automatic patterns scanning No No Yes 

Algorithms detecting 104 Japanese candle patterns Yes Yes Yes 

Symbol statistics Yes Yes Yes 

Symbols Group statistics No Yes Yes 

Technical Analysis indicators No Yes Yes 

Backtesting module No Yes Yes 

1.3 Technical requirements 

1.3.1 Software requirements 

In order to successfully run and use the CandleScanner application you need to have a computer with one of the following 
operating systems: 

 Microsoft Windows XP 

 Microsoft Windows Vista 

 Microsoft Windows 7 

 Microsoft Windows 8  

 Microsoft Windows 8.1 

Both versions are supported: 32-bit and 64-bit. 

Additionally, you need to have .NET Framework 4.0 or above installed on your computer. If this is not the case, please visit 
Microsoft website to download it and install it first on your machine, prior installing CandleScanner. 

contact@candlescanner.com
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1.3.2 Hardware requirements 

To run CandleScanner your computer need to have, as minimum, the following parameters: 

 Processor: 1 GHz or faster x86-bit or x64-bit with SSE2 

 Memory: 1 GB RAM (32-bit) or 2 GB RAM (64-bit) 

 Hard disk: 300 MB available disk space 

 Display: 1366 × 768 screen resolution 

1.4 Purchasing and installation process 

Depending on your needs, you can start using CandleScanner buying either a monthly subscription or as a one-time 
purchase. No matter which option you choose, the software is exactly the same in both cases. 

1.4.1 Licensing policy 

Once the application is bought the user has the following benefits: 

 

Purchase Option One-Time Purchase Subscription 

Updates Free for the first year since purchase Free during subscription period 

Price 
One-time fee for using the application 

lifetime without any limits 
Monthly fee 

Installations available 1 computer 1 computer 

Support 
Free technical support for one year 

since purchase 

Free technical support during 

subscription period 

 

All licenses are for one computer only. If you need to use the application on more than one computer please contact us 
at contact@candlescanner.com for special offer. 

 

 
Activation of the licences is an automatic process during the installation process. Active internet 

connection is required because the security keys are retrieved from the remote license server. 

CandleScanner will not work as a full version without these keys. 

Please do not distribute to anyone your user name and/or password which are used during the registration 

process. Every connection to the remote server is registered, and, if we notice any form of abuse, e.g. 

multiple license registrations under the same user credentials, we reserve the right to permanently revoke 

the license without any warning. 

1.4.2 CandleScanner subscription FAQ 

How do I renew my CandleScanner subscription? 

Go to http://shop.candlescanner.com and sign in to your account. There buy a subscription you want to renew. 

IMPORTANT: Make sure that you use the same CandleScanner account and the same CandleScanner edition that you 
used when setting up your original subscription. Any time you have remaining will be automatically added to your existing 

mailto:contact@candlescanner.com
http://shop.candlescanner.com/
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subscription. If you use a different CandleScanner account or different CandleScanner edition you will be creating a new 
subscription. 

 

Will I lose any time if I renew early? 

No. When you renew early to the same CandleScanner subscription that you already have, the additional time is added to 
your existing subscription. For example, if you have 2 days left on your current subscription to CandleScanner Professional 
and you buy a 1 month renewal, 1 month will be added and your subscription will be good for 1 month and 2 days. 

IMPORTANT: Make sure that you use the same CandleScanner account and the same CandleScanner edition that you 
used when setting up your original subscription. Any time you have remaining will be automatically added to your existing 
subscription. If you use a different CandleScanner account or different CandleScanner edition you will be creating a new 
subscription. 

 

I am renewing an existing subscription, do I need to re-download or re-install CandleScanner on my 
computer? 

No. 

 

How do I find out how much time I have left on my current subscription? 

Go to http://shop.candlescanner.com and sign in. Click on the menu located on the top right side of the page and go to 
Your Products section to see when your current subscription expires. 

 

What happens if my subscription ends and I haven’t renewed yet? 

If you choose to let your subscription expire, the CandleScanner software application stops working and cannot be 
launched. 

 

What happens if I buy or renew multiple CandleScanner subscriptions using the same account? 

Your account can have only one subscription associated with it. If you use the same account to buy or renew multiple 
CandleScanner subscriptions before each one has expired, you will add the cumulative time to your subscription. Note 
that doing so does not increase the number of devices that you can install CandleScanner. 

 

Can I switch from a monthly subscription plan to a one-time purchase license? 

No. A one-time purchase is a separate license 

 

What do I do if I need help? 

Just contact us at contact@candlescanner.com. 

1.4.3 Purchasing process 

All payments are made via PayPal ™ service. The whole process of purchasing CandleScanner is fully automated. Our 
shop is open 24 hours a day, 7 days a week. 

 

http://shop.candlescanner.com/
contact@candlescanner.com
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We encourage you to download the free trial version (fully operational for 14 days) to see if the 

application suits your expectations and needs. There are no refunds in respect of purchased 

licenses. 

 

 

Figure 1.1. The main page of CandleScanner website. From here you can buy either by using the marked Products menu or by 

scrolling the page down and selecting appropriate BUY NOW button.  

 

To purchase CandleScanner, you need to click on the BUY NOW button from the main site at http://candlescanner.com 
under the product you want to buy. Alternatively you can use the Products menu and from the page of particular product 
use the link navigating to our online shop. In both cases you will be navigated to our online shop at 
http://shop.candlescanner.com. 

When you are on the http://shop.candlescanner.com site, you will see the basket containing product you selected before. 
You can either proceed purchase process or add other product(s) to your basket.  

Clicking on the red rectangle (see Figure 1.2) you will be navigated to the main shop site from which you can add more 
products to your basket.  

Customer details area visible on the Figure 1.2 allows you to either sign in or create a new customer’s account.  

You can notice that purchase process is made of three steps and the screen above represents the first one. The second 
step shows the summary and finally the third one allows you to be navigated to the PayPal website where you can complete 
payment process. 

 

http://candlescanner.com/
http://shop.candlescanner.com/
http://shop.candlescanner.com/
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If you have a discount code you need to enter it in the field Discount code, and press Apply 

discount code button. Prices will be then recalculated on the items for which a discount code 

is valid. 

Please note that you can use your discount code only on this screen (i.e. first step of the purchase 

step). 

 
 

 
Figure 1.2. Online shop website. 
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After successful payment you receive an email with instructions on how to download and install the application on your 
computer. You will be automatically be navigated back to the http://candlescanner.com website. 

1.4.4 Installing your application 

In order to start the installation of CandleScanner you need to download it first. The download link you can find in the 
email which you receive after purchase. You can also navigate to the online shop at http://shop.candlescanner.com and 
after signing in select the Your products item from the menu (see Figure 1.3). 

 

 

Please note that an active internet connection is required to successfully complete the installation 

process. 

 

 

Figure 1.3. When you are signed in to our online shop (http://shop.candlescanner.com), use Your products menu to see the list of 
files available for you to download. 

 

After the successful download of the installation file, you need to run it, by double-clicking. The process is very 
straightforward and does not require any specific technical knowledge from the user. Simply follow the steps as they are 
displayed on the screen.  

 

 

While downloading the file, you may see warnings from your operating system/other security 

software that the file to be downloaded is potentially dangerous to your computer. All files 

downloaded from http://shop.candlescanner.com are digitally signed giving you the guarantee 

that they are absolutely secure for your machine and were not tampered with by anyone. In 

order to check if the downloaded file is digitally signed right-click on it, select Properties and 

then go to the Digital Signatures tab, which contains the details of the digital signature. If the 

Digital Signatures tab does not exist it means that the file has not been signed-off by us by 

and can therefore be potentially dangerous (that is, it could be tampered by anyone). 

 

When the user starts CandleScanner for the first time he/she will be asked to provide the registration data. It is exactly the 
same information that was used during creating an account on the website in order to purchase a product. 

http://candlescanner.com/
http://shop.candlescanner.com/
http://shop.candlescanner.com/
http://shop.candlescanner.com/
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1.4.5 Starting the application 

Once the installation process is finished, you are ready to run it. You can access the application via the shortcut created 
either on the Windows Desktop (if you selected this option during installation) or from the Start menu/screen. 

CandleScanner is distributed with some built-in market data so that you can immediately start working with it. You can 
remove this data and/or import your own. 

1.4.6 Updating your application 

Whenever newer version is available for download, you can simply perform the same steps as for normal installation. It is 
recommended to remove first the existing application to avoid any problems or conflicts with existing application. Before 
this, we highly recommend to backup any files or settings from your existing installation. 

1.4.7 Uninstalling your application 

Your application can be easily removed from your computer via Control Panel of your operating system: Control Panel 

» Uninstall a program, select the CandleScanner and press Uninstall button. Follow instructions to complete the 
process. 
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2 Basic theoretical concepts 

This section covers concepts and terminology related to candlesticks which are important to understand when using 
CandleScanner. In addition to the commonly known candlesticks, CandleScanner goes beyond the ‘basics’ and employs 
an advanced methodology which can be adapted by more experienced users. 

Less experienced users can simply look at the patterns recognized, and generated, by CandleScanner and just check their 
efficiency and other statistics. However, if you want a more in-depth understanding beyond basic candle patterns, it is 
important to learn and understand CandleScanners capabilities. 

This User Guide is not the place to go into a full discussion and interpretation of candle patterns in textbook fashion, 
especially into all of the potential bullish and bearish candlesticks patterns which exist. There are literally dozens of bullish 
and bearish candlestick reversal patterns. On our website, we are constantly extending the Patterns Dictionary 
(http://www.candlescanner.com/patterns-dictionary/), which explains the candlestick patterns. For new users, we 
recommend further background reading in order to familiarise themselves with the subject, and so, gain a more insightful 
and fuller experience in using CandleScanner.  

Perhaps at this point we would add a word of caution. In the context of candlestick analysis, the identification of candle 
patterns may be important, but that in-it-self is not a sufficient condition for profitable trading. Many texts on candlesticks 
will most often graphically show that the pattern had correctly signaled the subsequent price action and leave it at that. 
This can give the erroneous impression that to find the pattern on the chart is all the trader needs to do in order to make 
a profit. However, by merely looking at the resulting price profile ignores important considerations such as position 
management and risk management. A full assessment of the profitable success or otherwise of candle patterns requires 
back testing the results, based on candle signals and taking account of money and risk management. This is an aspect will 
be covered more thoroughly on the CandleScanner website. 

2.1 Candlestick construction 

The construction of the single candlestick, also known as the candle line, is based on the basic data in a single time interval 
and consists of the following (OHLC) components: 

 opening price (Open) 

 maximum price (High) 

 minimum price (Low) 

 closing price (Close) 

The time interval can be of any length spanning minutes, hours, days, weeks, months or years. However, if we are focused 
on candle patterns, most traders are interested in candles made from intervals not longer than one day. 

It is common to find OHLC representing the order for displaying the prices (open, high, low, close). 

The single candlestick is composed of three elements: upper shadow (jap. uwakage), lower shadow (jap. shitakage) and body (jap. 
jittai). The Candlestick body is determined by the opening and closing prices, represented by a rectangle. The color of the 
rectangle differs, depending on whether the opening price is higher or lower than the closing price.  

If the closing price is higher, which means that over the time interval we had an increase in price, the candle is referred to 
as a white candle. If the price decreased over given time interval, that is, the closing price is below the opening price, the 
candle is referred to as black candle.  

Traditionally, the Japanese used black and red. However, nowadays it is more common to use black and white or, if the 
candlestick is filled with color, is deemed to be decreasing candlestick (closing price below the opening price). Alternatively, 
if the candlestick is unfilled this indicates growth (closing price above opening price). Sometimes, filled red candles are 
used to denote a bearish candle (closing price below the opening price) and a filled green candle denotes a bullish candle 
(closing price above opening price). 

In CandleScanner the user can customize the look of the candlesticks in many ways which best fit his/her preferences. 

http://www.candlescanner.com/patterns-dictionary/
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Figure 2.1 shows the elements which make-up a candle and how it is drawn, depending on the relationship between the 
opening and closing prices. 

Please follow this link navigating to our website to see article devoted to the candlestick construction: 
http://www.candlescanner.com/candlestick-patterns/candlestick-construction-2/. 

 

 

Figure 2.1. Candlestick construction. 

2.1.1 Blended candlesticks 

We can ‘blend’ different adjacent candlesticks to form a single candlestick, thus summarizing the outcome over several 
periods in one candle. We can blend candles of similar frequency over any time scales, for example, minute-by-minute 
candles, hour-by-hour candles or day-by-day candles. You can blend as many adjacent candles as you see fit. In effect, by 
doing this you get a clearer insight into the evolution of market activity over longer time periods. Why would we want to 
do this? Well, first of all, blended candles can create a single, stronger signal. Secondly, by blending candles, you eliminate 
market noise, thereby getting a more accurate reflection of the underlying activity. Finally, continually watching individual 
candles play-out over short-time periods creates stress which can, and frequently does, result in prematurely stopping 
out/exiting positions; this can result in losses or less profit taking than originally targeted. 

The importance of the last point cannot be understated. The psychological aspect, reacting to short-term patterns, plagues 
most investors. Analyzing groups of blended candles enables us to keep a focus on our trading plan, thereby restraining 
the emotional reaction arising from adverse short-term price movements. In other words, it helps us not to get caught-up 
in the noise and to stick to our original trading plan, waiting for stops or targets to be reached, as set at the beginning of 
the trade. 

So, how does blending work? Very simply: first we decide how many candles we would like to blend, take the opening 
price of the first candle, the highest and lowest prices achieved across all candles and finally the closing price of the last 
candle. Using CandleScanner you are able to blend as many candles as you like. 

Figure 2.2 show the position for two candles. We have a down period with a relatively large body for the first candle, 
followed by a period with a larger body, which fully engulfs at the body of the previous period. 

The two individual candles form what is known as a Bullish Engulfing pattern, the single resulting blended candle being a 
Hammer/Hanging Man. Because basically they look the same, we can only differentiate between them by context, i.e. 
Hammer can be formed in a downtrend and the Hanging Man in an uptrend. The interpretation placed on the Hammer 
is that it signals a potential bullishness in the market, that is, a potential bullish reversal after a prolonged downtrend.  

To understand how to construct blended candlesticks we need first to understand the notion of base time interval used in 
CandleScanner. 

http://www.candlescanner.com/candlestick-patterns/candlestick-construction-2/
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The base time interval of the symbol is the minimal time interval which can be used for the given symbol which is imported 
into CandleScanner. For example, having imported the quotes of EUR/USD symbol expressed in 15-minute time intervals 
allows us to plot the chart as 15-minute chart, or any multiple of 15-minutes (e.g. 30-minutes, hourly, daily). With the base 
time interval equal to 15-minutes, you cannot, however, plot the chart made up of 20-minutes candlesticks. 

 

 

Figure 2.2. Blended candles result in a combination known as Hammer/Hanging Man. 

 

Some software on the markets allows this, but it does not make sense and, as a result, incorrect data is presented. When 
we have, say, 15-minutes quotes, it means that we have the following information: 

 Open price when the 15-minutes period begins 

 Close price when the 15-minutes period ends 

 High and low price over the 15-minutes period 

It is clear from this that we cannot plot 20-minute candles, as we do not have the full profile of market prices as at the end 
of the 20th minute. For this reason, CandleScanner does not allow you to plot charts in such cases. 

As described above, a blended candle is a candle which combines a specified number of individual candles for some base 
time interval. For example, a daily candle (i.e. the one which base interval is one day) can be used to build a blended candle 
made up of 3 such daily candles. So, as a result of blending 300 daily candles, we end up with a set of 100 3-daily candles. 

In CandleScanner, the user can create custom time intervals to plot on the chart. The following naming convention is 
used: 

 m is used for minutes; for example 1m = 1 minute, 2m = 2 minutes and so on 

 h is used for hours; for example 1h = 1 hour, 2h = 2 hours and so on 

 d is used for days; for example 1d = 1 day, 2d = 2 days and so on 

 w is used for weeks; for example 1w = 1 week, 2w = 2 weeks and so on 

 M is used for months; for example 1M = 1 month, 2M = 2 months and so on 

 Y is used for years; for example 1Y = 1 year, 2Y = 2 years and so on 

 c is used for base time interval candles; for example 1c = 1 candle, 2c = 2 candles and so on 

In CandleScanner you can switch the time interval in two ways: 

 Using the time interval buttons 

 Using the combo-box with user defined intervals 
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Please note that time interval (e.g. daily, weekly, monthly) is not always (and most likely is not) the 

same as the n base time interval candles i.e. the combination of an identical number of candles.  

It may so happen that, due to holiday, for example, there are less than 5 working days in a certain 

week. If we have daily candles (base time interval of the candle is one day) and display them on 

the chart in weekly time intervals, this combines the daily candles for the week in question, 

irrespective of how many actual daily candles there were that week (in this case, the weekly 

candle would be a blend consisting of 4 daily candles).  

Had we used a time interval consisting of 4 candles for a given week, say because of a one day 

holiday that week, the resulting profile of weekly blended candles would consist of different 

numbers of daily candles. For this reason, CandleScanner employs the notion of n base time 

interval candles. 

2.2 Short and long lines 

Candles differ in length, which is shown in the division of the candle.  The criterion for this division is fluid and depends 
on the current situation on the chart. The so-called short line is the one where the market volatility is very low (small price 
range). Similarly, the long line will be the one of high volatility (high price range). The short/long line can be displayed in 
CandleScanner with different colors so that they can readily be recognized. By default, the orange color is used for the 
short line and a green color for the long line. 

Knowing whether a candle is a short or long line is important to recognize correctly, and distinguish, between the many 
candle patterns. However, to know the details how exactly CandleScanner recognizes whether we have a short or long line 
is not necessary, especially for the less experienced users. 

 

 

Figure 2.3. Pfizer Inc. long lines (green) and short lines (orange). Candle length depends on the current volatility of the last 25 sessions, 
which means that the green candlesticks may have very different span (and still be seen as long lines). Other colors used on the chart 
are explained in subsequent sections. Please note that such a color theme is implemented in CandleScanner, but the user can also switch 
to a simple traditional two-color scheme with black and white candles (or other). Using more colors helps, for example, to accept or 
reject certain candle pattern as valid/invalid. 
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It is assumed in CandleScanner that the decisions as to whether we are dealing with a long or a short line, we take the whole 
candle into account (the body with the shadows).  

A common analyst’s mistake is to look at the historical chart and determine the height and dynamics of the candle, not 
only on the basis of the historical prices but also on future candles. However, while the candlestick is being formed, we 
do not know the future yet. Therefore, we should not use the information about the future volatility of the market. 

Figure 2.3 shows that the green candles, representing a long line, have very different spans. For example, the September 
long lines are significantly shorter than those as at the end of October. But, in both cases, we deal with long lines although 
in different market conditions. 

 

 

Long/short line is also known as a long/short day. The term "day" (short or long) refers to a single 

line of candle and derives from the period, where the charts were created on the basis of daily 

quotations. In the case of charts constructed on the basis of intraday prices, (for example 5 

minutes, hourly or others), such a term can be confusing. For this reason, in CandleScanner the 

term long/short line is used to avoid any misunderstanding. 

Moreover, in Greg Morris’s book titled "Candlestick Charting Explained", such phrases as long days 

and short days are referring only to the height of the candle body. This is a surprising approach, 

because that would mean that the candle with a small body and with very long shadows would 

be considered as constituting a short day, indicating low volatility during the day. Therefore, it 

might be considered that this was some simplification on the part of Morris. To repeat, 

CandleScanner takes into account the whole candle height, i.e. the body and the shadows if 

they exist. 

 

Figure 2.4. Determination of the short and the long line, depending on the average price range. The green line shows 70% of price 
volatility for the last 25 bars. We can notice that when the candle height exceeds the green line it is marked as green, meaning that we 
are dealing with a long line. All candles whose height is below the green line are marked in yellow – these are short lines. The red and 
dark blue candles are described in section 2.3. 
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By default CandleScanner adopts the following rule determining whether the candle is a long or a short line: it sets the 
current range of volatility as an exponential average distance between the highest and lowest prices of individual candles 
for the last 25 candles. A candle which spans more than 70 percent of this volatility value is regarded as a long line. Candles 
below this threshold are regarded as short lines.  

Figure 3.4 illustrates the process of determining the short and a long line. Red lines designate the average range of volatility 
for the last 25 candles. The green line in the middle indicates 70 percent of the range between red lines. Each candle 
located below this threshold is classified as a short line and marked with the orange color. Dark blue and red candles will 
be discussed later. 

The parameter value of 70 percent was arbitrarily chosen. Normally, this depends on personal preference, and 
CandleScanner allows the user to change this to meet specific requirements. Nevertheless, it is good to remember that the 
more we increase this parameter, the more short lines we will have, and vice versa when we lower the value, there will be 
more long lines. This also has an impact on the number of identified candle patterns found by CandleScanner. Despite 
the discretion, we should remember that the optimal range is somewhere between 65 and 80 percent of the span. 

 

 

Please follow this link https://www.youtube.com/watch?v=3jKZuMM9hlk to watch the video 

explaining the short/long line notion. 

 

2.3 Basic candles 

Given the requirement for information on four prices, OHLC, in order to construct a candle, the resulting candle shapes 
can take on a variety of forms. The body may be very long or very short, and similarly for shadows. However, either the 
body or the shadows may sometimes not appear at all. This multitude of combinations allows a grouping the candles based 
on their appearance, enabling them to be interpreted. All the individual candles are called basic candles. Most of them are 
not patterns as such, but they can often play an important role in the assessment of the current situation of the market 
and its possible further development. Basic candles are components of more complex patterns which can contain two, 
three or even more basic candles. 

The detailed construction of basic candles (and candle patterns) is described on our website:  

http://www.candlescanner.com/candlestick-patterns/basic-candles/. 

2.3.1 Candles with different open and close prices 

Candles with different opening and closing prices having two shadows (upper and lower) and, with a longer body than the 
shadows, are denoted as follows: 

 Short White Candle (short line) 

 White Candle (long line) 

 Long White Candle (long line)  

 Short Black Candle (short line) 

 Black Candle (long line) 

 Long Black Candle (long line) 

2.3.2 Marubozu candles 

Candles with different opening and closing prices, but not having at least one shadow, are called marubozu (jap. shaved head). 
In the case when a single shadow exists, the candlestick body must be longer than the shadow. Marubozu candles occur 
both for the short and long line.  

Marubozu candles can be one of the following: 

https://www.youtube.com/watch?v=3jKZuMM9hlk
http://www.candlescanner.com/candlestick-patterns/basic-candles/


CANDLESCANNER USER’S GUIDE 22 

 

 

 White Marubozu 

 Opening White Marubozu 

 Closing White Marubozu 

 Black Marubozu 

 Opening Black Marubozu 

 Closing Black Marubozu 

2.3.3 Spinning tops 

Candlesticks with different opening and closing prices and having at least one shadow, where at least one shadow has to 
be longer than the body, are called spinning tops. The following types of spinning tops are possible: 

 White Spinning Top (short and long line if none of the shadows are three times longer than the body) 

 Black Spinning Top (short and long line if none of the shadows are three times longer than the body) 

 High Wave – a kind of spinning top occurring on a long line (if one of the shadows is at least three times longer 
than the body). 

In CandleScanner spinning tops are marked by default in dark blue color. 

2.3.4 Doji candles 

Candles, in which there is no body because the opening price is equal to the closing price are called doji candles (jap. fool, 
clumsy, slip of the tongue). 

Note that CandleScanner can also classify a candle as a doji when the opening and closing prices differ by a very small 
amount (in theory, a doji should not have a body, but the difference may be negligible and then on the chart is hardly 
visible). Doji may occur with or without shadows. There are the following types of doji candles: 

 Four-Price Doji (short line) 

 Long-Legged Doji (long line) 

 Dragonfly Doji (long line) 

 Gravestone Doji (long line) 

 Doji (short or long line) 

In CandleScanner, the doji candles are marked in red color by default when using the CandleScanner color theme. All of these 
basic candles can be part of candlestick patterns, and, therefore, it is important to know if we are dealing with a doji candle 
or a spinning top. It is easy to mix them up when a spinning top has a very small body, which looks on the chart as if the 
open and close prices are equal. 

2.4 Candlestick charts: CandleScanner color theme 

Almost all of the western literature devoted to candlesticks has simplified the analysis by limiting the candle colors to dark 
(black) and light (white) body. According to Seiki Shimizu, the colors of candles were originally much more complex, 
which he demonstrated in the example of a doji candle, in which there is only a shadow line and a line marking the opening 
price equal to the closing price. 
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Figure 2.5. Alcoa Inc. candlestick chart using CandleScanner Color Theme. Due to using colors it is very easy to see long/short lines (green 
and yellow candlesticks respectively), spinning tops (blue candlesticks) and doji candles (red candlesticks). 

 

With high price volatility over short time intervals, when the price jumps, for example, by some 30 percent, some candles 
can look as insignificant points on the chart. The use of color immediately explains and shows the nature of the candle. In 
CandleScanner users can display colors of their choice in the candlestick charts using the CandleScanner Color Theme. The 
following colors can be displayed: 

 green – long lines 

 orange (dark yellow) – short lines 

 blue – all kinds of spinning tops 

 red – all types of doji candles 

Figure 2.5 shows a candlesticks chart using the CandleScanner Color Theme. This theme is optional, and can be switched off 
if you prefer a simple candlesticks chart using just two colors. Notice that it makes to use the CandleScanner Color Theme if 
you want to quickly spot the difference between short/long lines and spinning tops/doji candles. For example, some doji 
candles are marked in blue color rather than red as was previously mentioned. This is because in fact such candles are 
indeed spinning tops and not doji candles, but their bodies are so small that on the chart they look as if the open and close 
prices are the same. Hence, most people just looking on the chart would say that they see a doji candle, although in fact it 
is a spinning top. 

Again, the distinction as to which exact candle we have on the chart is crucial in correctly recognizing the candle pattern. 
CandleScanner enables the user to adjust the settings of the searching algorithms to meet specific requirements. For 
example, the CandleScanner algorithm searching for doji candles can be adjusted to accept small deviations from the strict 
doji definition which says that such candles do not have a body (open and close prices are equal). This can be helpful while 
dealing with larger candles. We can then define in CandleScanner to accept as doji candles such cases where body length 
is up to 3% of the whole candle length. Similarly, CandleScanner allows defining the threshold for long/short lines. 
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2.5 Price trend and price averages 

Probably one of the easiest ways to determine trend is the use of moving averages. Moving average is simply an average 
of prices (for example close prices) for a certain number of candles. The shorter the period (fewer candlesticks) to calculate 
an average the more likely is to be dominated by noise, rather than reflect an underlying trend. 

In CandleScanner, there are three basic types of averages: simple, weighted and exponential. The first is the arithmetic 
average, where each price has the same impact (i.e. equal weight) on the trend value. The other two measures take account 
the element of time where, essentially, the more distant candle prices have less impact on the calculated trend value and 
the more recent prices have a greater impact. Consequently, the weighted and exponential averages respond faster to recent 
price changes than does the simple average. 

It is generally the case that the trend is downward if the prices (candlesticks) are below the calculated average line and the 
trend is upward if they are above it.  

Trend is very important in terms of the candle patterns. Every candle pattern is anticipating either a continuation of the 
current trend or its reversal. There are, essentially, the following types of candle patterns in terms of the price trend: 

 bullish reversal patterns – reversing downtrend into an uptrend 

 bullish continuation patterns – continuation of uptrend 

 bearish reversal patterns – reversing uptrend into downtrend 

 bearish continuation patterns – continuation of downtrend 

In CandleScanner the user can set the following parameters related to price trend: 

 the period (number of candles) of the moving average used as a trend indicator 

 the type of average used as a trend indicator 

 how long the required trend needs to last in order to consider established candle pattern as valid 

All the above parameters have an impact on the number of candle patterns found by CandleScanner. 

 

 

Figure 2.6. A so-called Bearish Engulfing candle pattern is forecasting a reversal of an uptrend into a downtrend. The first Bearish Engulfing 
pattern is not recognized as a valid pattern because the trend requirement was not met (candles were not above the moving average 
line). In this particular case, CandleScanner required that an uptrend needs to last at least three candles (days) prior to the occurrence 
of the candle pattern. 
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As an example, Figure 2.6 shows how the classification of patterns works according to the trend on the chart. We have 
three examples of the candle patterns typical for a bear market. To be considered a bearish reversal signal, there should be 
an existing uptrend to reverse. However, only in the second and third case, with a simple moving average of 10 candles 
clearly indicating the uptrend, we consider a bearish reversal pattern as valid. In the first case, despite the fact that bearish 
reversal candle pattern occurred, ultimately it is not recognized as a valid one – the uptrend lasted only for one candle (one 
day in this case) which is not enough. 
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3 Basic interface operations 

I this section we describe the basics of CandleScanner, which are used most often on a daily basis by users. 

3.1 Main window interface 

CandleScanner is a highly customizable application which can be configured to meet user's specific requirements. The 
application is composed of several windows which can be managed in many ways. CandleScanner implements a so called 
docking system which is employed in other professional specialized software such as Microsoft Visual Studio and used to 
develop software. 

CandleScanner has the following features with regard to its windows management system: 

 Containers for windows contain dockable windows. Containers can fill the entire CandleScanner area or can be 
limited to any rectangular area chosen by the user. 

 Tabbed windows which can be switched between, resized, dragged to arrange in various configurations and closed. 

 Windows from the main CandleScanner window can be dragged outside their containers (so called floating windows), 
dragged to other containers or  collapsed and transformed to tabbed documents (this is possible only for so called 
tool windows). 

 The user has complete control over sizing and layout behavior. 

 CandleScanner remembers the recent layout and restores it when starting the application. 
 

 

CandleScanner provides the option to reset windows layout to its default settings. This may be 

helpful especially for less experienced users, who after several changes within CandleScanner 

windows layout, may want to go back to the original settings. 

To set CandleScanner default windows layout click VIEW » Windows Layout » Default 

Layout button on the ribbon bar. Please note that your current settings of the windows layout 

will be lost. 

 

3.1.1 Understanding windows docking system 

There are two main types (classes) of windows within the main CandleScanner window: documents windows and tool windows, 
shown in Figure 3.1. They are used for different purposes. Document windows are mainly used to present some content 
in CandleScanner like candlestick charts, statistics or candlestick pattern dictionary. Tool windows are more auxiliary in 
nature and in CandleScanner are used mainly to change the current content(s) in the document window or to change the 
content of other tool windows. Both types have separate types of containers within which they can be docked. 

 

 

The container is just a place in which a specific window can be docked (placed). 

The Container for tool windows can contain only tool windows. However, the document 

container can contain both, namely, the document and tool windows.  

This means, for example, that the Symbols window (which is of type tool window) can be 

docked in the documents container, along with other documents like, for example, candlestick 

charts. The reverse is not possible, however. 
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For example, when in CandleScanner there is a document window open with a candlestick chart, and we can click on the 
tool window and select different symbols from the list. By doing this, the document window with the candlestick chart 
will reload the content to display data for the newly selected symbol. If however, the currently opened document is of a 
different type, for example containing a Patterns Dictionary, then clicking on the same list of symbols in the tool 
window would not change anything. This is because not all documents have to be connected with tool windows – 
candlestick Patterns Dictionary is an example. No matter what symbol is selected in the tool window with symbols, the 
document with the dictionary stays the same. 

 

 

Figure 3.1. Displayed are the tool windows (green rectangle) and document windows (red rectangle). Windows from the green area can 
be docked in the red rectangle, but the opposite is not possible (i.e. document windows cannot be docked in the tools container). 

 

Clicking on the tool window can have an impact on the content of another tool window. In CandleScanner, for example, 
there is a tool window with list of symbol groups (e.g. S&P 500) and another one with symbols belonging to the specific 
group. Changing different symbol group from the list reloads the list of symbols and displays symbols from the newly 
selected group. This mechanism is presented in the Figure 3.2. 

Another difference between document windows and tool windows is in the way they can be managed within 
CandleScanner. Because tool windows are auxiliary they can be pinned opened or unpinned and then auto-hidden (i.e. 
collapsed against the nearest side of the tool window container). When there are any hidden tool windows (i.e. unpinned), 
there is a so called auto-hide tool tab strip visible. The Auto-hide tool tab strip contains all the hidden windows in minimized 
form, displaying just their names without the content. Clicking on them expands the hidden window. When the mouse is 
not hovered over the unpinned tool window, it will minimize, automatically, into the auto-hide tool tab strip again. This 
can be very helpful because it may happen that we want to have more working space to display, for example, a document 
window with candlestick charts. Hidden (unpinned) tool windows can be pinned if we want to them to be always visible. 

Differences in the behavior of the document windows vs. tool windows are also reflected in their context menus. 
Document window has commands for closing windows, creating new horizontal and vertical tab groups and for moving 
windows between groups. Tool window context menu has commands that allow the panel to be Floating, Dockable 
(causes the panel to dock) or Tabbed Document.  If Tabbed Document is selected the tool window becomes hosted 
in a tab strip container along with the tabbed documents. Auto Hide causes the panel to be unpinned and collapsed. Hide 
makes the panel invisible.  
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The anatomy of the windows management system in CandleScanner is shown in the Figure 3.3. Some of the components 
presented on that figure are described in the subsequent subsections. 

 

 

Figure 3.2. Clicking on the S&P 500 item in the Groups tool window causes the reloading of the S&P 500 components in the 

Symbols tool window, which then displays the S&P 500 components (symbols), as shown. 

 

 

Figure 3.3. Anatomy of CandleScanner windows. Tool windows are in green rectangles (called tool tab strips). In the yellow rectangle, 
there is a document window container which is divided by a splitter bar (violet line). We can see two document tab strips (red rectangles). Tool 
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windows can be docked on the document window container, but the opposite is not possible. The blue rectangle is used for auto-hiding 
tool windows. 

3.1.2 Arranging docking windows 

A tool tab strip container can include one or more tool windows. You can drag a tool window in the following ways: 

 Within a tool tab strip 

 From one tool tab strip to another existing tool tab strip 

 From one tool tab strip to a new tool tab strip 

 From a tool tab strip on a form to a floating tool tab strip 

 From a floating tool tab strip to a docked tool tab strip 

To move a tool window, drag its title bar from the source location to the new target (or host) container. The docking assistant 
(for details see the subsection Docking windows assistant) allows you to place the tool window in a specific relationship to the 
other panels. 

Besides to moving tool window in different tool tab strip containers, you can use the context menu or “pin” icon in the 
dock panel title bar to make window auto-hidden. This mode collapses the window against an edge of the CandleScanner. 
Another option is to move a tool window to a container with tabbed documents. Both of these options: 

 Save critical space on the end user screen 

 Allow more information to be presented at run time 

 Allow the end user to customize their work space 

Another aspect is resizing of the panel. To resize a tool tab strip/document tab strip container, click the splitter bar between 
two adjacent docking containers and drag the splitter to the desired location. Containers will automatically resize 
themselves to fit the space available. You can find the splitter bar between docking containers, as shown in Figure 3.4. 

To begin resizing move the mouse over the splitter area until the splitter mouse icon appears (the icon is a line with upward 
and downward pointing arrows). Then hold the left mouse button down and drag the splitter to a new location. To 
complete the resize, release the mouse button, dropping the splitter bar in its new location. The panels to either side of 
the splitter will be resized in relation to the new splitter position. 

 

 

Figure 3.4. When the mouse hovers over the splitter bar the mouse icon changes into line with bidirectional arrow pointers. 

3.1.3 Docking windows assistant 

The so-called docking windows assistant is a feature in CandleScanner, which helps to pinpoint drag-drop destinations for 
windows being moved within the application. 
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Figure 3.5. Drop hint is a shaded blue rectangle in the top right side of the window. It shows where the window will be located after 
the drop. After the drop is made, CandleScanner automatically resizes windows' containers to fill the available space. 

 

This tool is made up of an outer zone and an inner zone of controls. The outer zone consists of four satellite grips, situated 
at the four points of a virtual compass over the docking container. It is used for positioning a window relative to the 
primary host container. The inner zone has a center compass with icons for positioning a window in the underlying docking 
container or in another docking container relative to the underlying one. All of these icons represent a drop target, i.e. the 
destination for the window you are moving. 

To use the docking windows assistant, use the mouse to select the title bar of the source window. Drag the window over 
the host (destination) container. This action activates the docking windows assistant. Point to the inner or outer zone icon 
that represents the area you want the window to occupy. When the mouse button is released, the window is relocated. 
Other windows in the host container, as well as other docking containers within the application, are relocated to 
accommodate the change. 

In addition to the drop target icons, the docking assistant displays docking hints. A docking hint is a visual preview of 
what space will be occupied by a window. Drop hints are enabled when you are in the process of moving the window and 
while the mouse pointer is positioned over one of the drop targets. 

3.1.4 Floating windows 

Both document and tool windows can be switched into so-called floating mode. 

There are multiple ways to float a tool window: 

 Drag the tool window out of the docked container area to an existing floating container 

 Drag the tool window to any area within the docking assistant other than a drop target icon, CandleScanner will 
create a new floating container with the tool window in it 

 Right-click the title bar and select Floating from the context menu (works only for the tool windows) 

 Double-click the title bar  

To "un-float" a tool window, drag the title bar to a docked container, or double-click the title bar. 
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Figure 3.6. Floating window. This can be helpful for example when we want to use CandleScanner on more than one monitor. 

3.1.5 Auto-hiding windows 

If you want a tool window to auto-hide, un-pin the tool window by clicking the pushpin icon in the title bar. This will 
cause the window to auto-hide at the edge of the container to which it belongs. The screen shots below show the situation 
before and after un-pinning the panel. 

 

 

Figure 3.7. Pinned Properties tool window (marked in red rectangle). Please note on the buttons available in the top right corner 
you can close or unpin (hide) the window. 
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By hovering the mouse over the tab at the edge of the container that displays the window title will cause the window to 
slide out over the other panels. As long as the mouse cursor is over the tab or the panel itself, the panel will stay visible. 
Moving the mouse away from the tab and panel will cause the panel to collapse again to its un-pinned state. To dock the 
panel, click the "pin" button to pin the panel in place. 

 

 

Figure 3.8. Unpinned (hidden) Properties tool window. 

 

 

Figure 3.9. Showing hidden tool window. Note that a mouse cursor is over the tab. 
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3.1.6 Keyboard support 

Some users prefer to use the keyboard rather than the mouse. CandleScanner enables the user to switch between windows 
using the keyboard. By pressing CTRL+TAB the navigator selector window will appear. Leave the CTRL button depressed 
and press the TAB button to scroll through the names of the open CandleScanner windows. A list of windows in the 
navigator selector window sorts them by type, i.e. tool windows and document windows. To switch between these two 
groups use the mouse or arrow keys. 

3.1.7 Ribbon menu bar 

Ribbon bar control provides a flexible way for organizing all of the functionality in CandleScanner: 

 The entire application functionality is accessible from a single place 

 The Ribbon in CandleScanner is divided into the tabs HOME, DATA and VIEW. These tabs are permanently 
visible 

 There is also tab which is shown contextually: BACKTEST 

 When the users click on a tab, they are presented with the ribbon groups such as New Window or Active 

Window in the HOME tab 

 

 

Figure 3.10. Ribbon bar provides a flexible way for organizing all the functionality of CandleScanner. 

 

Tabs which are shown only contextually improve CandleScanner’s usability. When user is working with the chart document, 
the BACKTEST tab is hidden. This is useful, because in the context of a chart document none of the actions available in 
that tab are relevant. When user opens a new backtest document or switches to an already opened backtest document 
making it active, the BACKTEST tab appears. When the user switches back to the chart document the BACKTEST tab 
disappears. The HOME tab is available at all times. 

3.1.8 Data manipulation within tables 

Many components in the CandleScanner application are displayed in tables which allow the user to manipulate the data 
easily. Key features of such data manipulation includes: 

 Sorting. Many CandleScanner tables support data sorting. When sorting is enabled, the user can click on the 
column headers to control the sorting order. 

 Filtering. Excel-Like filtering offers a way for filtering data in a table by the end user. It is built in a way to mimic 
the standard Excel filtering functionality and offers a dialog, which contains a list of distinct column values, from 
which the end user can choose. 

 Column reordering. Some tables in CandleScanner supports column reordering by the user at run-time. The user 
has just to drag the desired column's header at the desired position among the other headers and drop it there. 

Once you become familiar how these features work in one place, you may found them in other places working in the same 
fashion. 
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3.1.9 Application themes 

CandleScanner can be used with different color themes to meet your personal requirements. The application can be run 
in two different colour themes:  

 Blue 

 Dark 

A stylish Dark look and feel is much less distracting for many people whereas Blue look is very much similar to most 
other applications you may already are using. 

In order to change the theme navigate to: File » Settings » General » Theme. Please note that in changing the 
application theme you are forced to reopen the application. 

 

 

Figure 3.11. CandleScanner in Dark Theme. 

3.2 Importing data quotes into CandleScanner 

In this section, you will find information on the types of data formats supported by CandleScanner and how to load your 
data. 

3.2.1 Supported data formats 

In order to import data into CandleScanner, it needs to be saved in one of the following formats: 

 ASCII (American Standard Code for Information Interchange) text format. Data files are plain text files which 
can be opened in any text editor (e.g. Windows Notepad). Every single line in such file contains as a minimum: 
date and four prices (open, high, low, close), which is enough to plot a candlestick on the chart. Some files can 
also contain more data like: time (for intraday quotes), volume or open interest (futures). CandleScanner can read 
ASCII file with market quotes in a form so-called comma-separated values (CSV) file which has a separator 
character between fields. Before importing such data into CandleScanner, we need to provide information 
explaining how to interpret the file format (e.g. what is the separator character or the meaning of the fields). 
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 MetaStock data format. This format is widely used to store market quotes. The advantage of this format over 
the ASCII format is the ease of import because the user does not have to provide information how to interpret 
the file. The drawback, however, can be that it cannot be opened and read in the text editor because this is a 
binary format (i.e. understandable only by the computer). 

 CandleScanner format. You obtain this data format if you use the CandleQuote application. Technically, this 
format is saved as an ASCII file, but in a way which enables simple import into the CandleScanner application. 

 CRB PRO format. This is a binary file format created by the Commodity Research Bureau (CRB). For more 
please check the following link: http://www.crbtrader.com/support/prodesc.asp. 

 

 

Figure 3.12. Buttons for importing data into CandleScanner. 

3.2.2 Requirements for the maximum data size and minimal time interval 

CandleScanner accepts a data size up to 500,000 quotes (half million) per symbol, with the minimal time interval of 1 
minute.  This for most users probably more than sufficient. For example, 500,000 quotes are equal to: 

 347 days of 1-minute time intervals 

 83 years (assuming there is 250 trading days in a year) of hourly time intervals 

 2000 years (assuming there is 250 trading days in a year) of daily data 

In general, it is best to make sure that the loaded data sets are no larger than needed because, the larger the data to process 
the lower the performance of the application. 

3.2.3 Organizing imported symbols into groups 

You can think of groups in CandleScanner as of folders (directories) in your operating system where you store your files 
(called symbols in CandleScanner terminology). For example, you decide to create a NASDAQ group, into which you import 
all the components (symbols) for this particular stock index.  

There are a few restrictions and rules which apply to both groups and symbols: 

 Groups cannot be embedded within other groups 

 Every group must be either of type intraday or EOD (end-of-day) 

 Group names have to be unique 

 Symbols always belong to a particular group 

 Symbol names (tickers) must be unique within a given group (the same symbol name can exist, however, in other 
groups) 

 Group always is assigned to one specific Scanner Settings 

http://www.crbtrader.com/support/prodesc.asp
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You can move symbols between groups similarly as you can move files between folders in your operating system. Symbols 
can be moved to other groups if they are the same type as the current group. You also can remove (delete) symbols from 
the group. Groups can also be renamed.  

When you create a group and import symbols, CandleScanner assigns to the group a type reflecting the time interval. There 
two types: intraday for all data quotes smaller than a day, and EOD (end-of-day) for daily quotes. Groups of type EOD 
cannot store symbols of type intraday. 

Every group has always assigned a specific Scanner Settings, which defines the detailed conditions for searching algorithms 
recognizing the patterns.  

 

 

Intraday symbols can be stored in the same group even if they have a different base time interval 

(i.e. the time in which prices are quoted for the given symbol in the file).  

For example, you can put to the same intraday group 15-minutes EUR/USD and 1-minute EUR/CHF. 

However, it is recommended to avoid this practice and create separate groups for every base 

time interval. 

Organizing symbols this way introduces clarity, especially when it comes to the calculation of 

statistics for the whole group (for more details please go to Group Statistics section). 

Please also note that Scanner Settings have a great impact on patterns efficiency statistics. 

For example settings for 1-minute bars will be most probably irrelevant for 180-minute bars. 

3.2.4 Importing MetaStock data quotes 

To import data into CandleScanner from Metastock files click the Import » Metastock button from the DATA menu 
on the ribbon bar. This opens the Metastock Data Import Wizard which guides you through the whole process. There 
are 4 steps within this wizard. If you need, you can use the < Back button to return to the previous step. 

 

STEP 1 

1. Specify the folder on your computer where the Metastock files are stored by clicking the button beside the Select 

folder containing Metastcok data text field. 
2. Select checkbox Automatic quote update if you would like CandleScanner to read the directory from which 

you are importing to (for more see Automatic quotes update section in this chapter). 
3. Press Next > button. 

 

STEP 2 

1. Wizard reads the folder specified in STEP 1 and displays all available symbols on the left side. Select symbols 
which you want to import into CandleScanner and press > button. You can also add all symbols by clicking on 
the >> button. If you want to do the opposite use < and << buttons respectively. You can select more than 
one element by pressing CTRL button or SHIFT button to select multiple rows at once. 

2. Press Next > button. 

 

STEP 3 

1. Specify into which symbols group you want to store the imported symbols. You can either select one from the 
already existing groups (option Existing group) or create a new one (option New group). Note that if you 
specify a group it has to be of the same type, i.e. intraday or EOD as the data which is being imported. 

2. Press Next > button. 

 

STEP 4 
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1. The importing process is completed. If any problems were encountered during the import, you will see details in 
the lower panel of this screen. 

2. Press Finish button. 

3.2.5 Importing ASCII data quotes 

To import data to CandleScanner from text file click Import » Text File button from the DATA menu on the ribbon 
bar. This opens ASCII Data Import Wizard, which guides through the whole process. There are 5 steps in this wizard. 
If you need you can use < Back button to return to the previous step. 

 

STEP 1 

1. Specify the folder on your computer where the ASCII data is stored by clicking … button beside the Select 

folder containing ASCII data text field. 
2. In the field Import schema (optional) you can select an import schema which simplifies the import process. 

Please note that import schema need to be first created and also it has to be appropriate for the data being 
imported. 
 

 

Import schema is a kind of a description of the ASCII format file. In the schema there is information 

specifying the exact set of the columns, its sequence and data type.  

ASCII files can have a different set of columns, and some values can be written in different formats 

(date and time can be written in many possible ways).  

Therefore, if you imported once ASCII files to CandleScanner you had to provide all these 

information in the ASCII Data Import Wizard. At the end of the import process, you can save 

this as an import schema which can be reused next time while importing data with the same 

format. 

 
3. Select checkbox Automatic quote update if you want to make CandleScanner read the directory from which 

you are importing to see new quotes (for more see Automatic quotes update section in this chapter). 
4. Press Next > button. 

 

STEP 2 

1. Wizard reads the folder specified in STEP 1 and displays all available symbols on the left side. Select symbols 
which you want to import to CandleScanner and press > button. You can also add all symbols by clicking on the 
>> button. If you want to do the opposite use < and << button respectively. You can select more than one 
element by pressing CTRL button or SHIFT button to select multiple rows at once. 

2. Press Next > button. 

 

STEP 3 

1. Specify in which symbols group you want to store the imported symbols. You can either select one from the 
already existing groups (option Existing group) or create a new one (option New group). Note that if you 
specify a group it has to be of the same type, i.e. intraday or EOD as the data which is being imported. 

2. Press Next > button. 

 

STEP 4 (skipped if import schema was selected in STEP 1) 

1. Assign to each column an appropriate data type. Application displays first rows of the file, split into columns, to 
make the process easier. Right-click on every column and select the data type. 

2. Press Next > button. 
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STEP 5 

1. The importing process is completed. You can save current import settings as an import schema and use them next 
time to optimize the import process. If any problems were encountered during the import, you will see details in 
the lower panel of this screen. 

2. Press Finish button. 

3.2.6 Importing CRB PRO data quotes 

To import data into CandleScanner from CRB PRO files click the Import » CBR PRO button from the DATA menu on 
the ribbon bar. This opens the PRO Data Import Wizard which guides you through the whole process. There are 4 
steps within this wizard. If you need, you can use the < Back button to return to the previous step. 

 

STEP 1 

1. Specify the folder on your computer where the PRO files are stored by clicking the button beside the Select 

folder containing PRO data text field. 
2. Select checkbox Automatic quote update if you would like CandleScanner to read the directory from which 

you are importing to (for more see Automatic quotes update section in this chapter). 
3. Press Next > button. 

 

STEP 2 

1. Wizard reads the folder specified in STEP 1 and displays all available symbols on the left side. Select symbols 
which you want to import into CandleScanner and press > button. You can also add all symbols by clicking on 
the >> button. If you want to do the opposite use < and << buttons respectively. You can select more than 
one element by pressing CTRL button or SHIFT button to select multiple rows at once. 

2. Press Next > button. 

 

STEP 3 

1. Specify into which symbols group you want to store the imported symbols. You can either select one from the 
already existing groups (option Existing group) or create a new one (option New group). Note that if you 
specify a group it has to be of the same type, i.e. intraday or EOD as the data which is being imported. 

2. Press Next > button. 

 

STEP 4 

1. The importing process is completed. If any problems were encountered during the import, you will see details in 
the lower panel of this screen. 

2. Press Finish button. 

3.2.7 Using the CandleQuote application as a data source 

CandleQuote™ is an application which can be combined with CandleScanner to get free data quotes using YAHOO! 
Finance service.  You can buy it on CandleScanner website. 

First you use CandleQuote application to download data quotes which are interesting for you. Then you export data quotes 
to a text file (ASCII file in CSV format). This data is compatible with any trading tool supporting EOD ASCII files. 

You can also export data to format which can be easily understood by CandleScanner, called CandleScanner format. For more 
on CandleQuote please follow this link: http://www.candlescanner.com/portfolio/candlequote/. 

 

http://www.candlescanner.com/portfolio/candlequote/
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Internally when you export data from CandleQuote in "CandleScanner format" it is saved in ASCII 

file but with the structure which CandleScanner can understand. This is why you do not have to 

tell CandleScanner during import process what is the structure of the imported data when it is in 

the CandleScanner format. 

 

To import data to CandleScanner from CandleScanner files click Import » CandleScanner button from the DATA menu 
on the ribbon bar. This opens CandleScanner Data Import Wizard which guides you through the whole process. There 
are 4 steps within this wizard. If you need you can use < Back button to return to the previous step. 

 

STEP 1 

1. Specify the folder on your computer where the CandleScanner files are stored by clicking … button beside the 
Select folder containing CandleScanner data text field. 

2. Select checkbox Automatic quote update if you want to make CandleScanner to read the directory from 
which you are importing to see new quotes (for more see Automatic quotes update section in this chapter). 

3. Press Next > button. 

 

STEP 2 

1. Wizard reads the folder specified in STEP 1 and displays all available symbols on the left side. Select symbols 
which you want to import to CandleScanner and press > button. You can also add all symbols by clicking on the 
>> button. If you want to do the opposite use < and << button respectively. You can select more than one 
element by pressing CTRL button or SHIFT button to select multiple rows at once. 

2. Press Next > button. 

 

STEP 3 

1. Specify in which symbols group you want to store the imported symbols. You can either select one from the 
already existing groups (option Existing group) or create a new one (option New group). Note that if you 
specify a group it has to be of the same type, i.e. intraday or EOD as the data which is being imported. 

2. Press Next > button. 

 

STEP 4 

1. The importing process is completed. If any problems were encountered during the import you will see details in 
the lower panel of this screen. 

2. Press Finish button. 

3.2.8 Importing data from MetaTrader 

MetaTrader allows to export data to external ASCII files which can be read by CandleScanner. 

To export data from MetaTrader perform following steps: 

1. From the menu in MetaTrader select Tools » Historical Center. 
2. From the left panel select interesting symbol and time interval. Double-click on the interesting element and data 

will be loaded in the right panel. 
3. Click on the Export button to export data into an external file. 
4. Exported data can be loaded into CandleScanner as it is described in Importing ASCII data quotes section in this 

chapter. 
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3.2.9 Automatic quotes update 

The Automatic quotes update simplifies updating of already imported data with new quotes. When you select this option, you 
can update this folder with newer data and CandleScanner automatically update, without the necessity of having to go 
through the steps in the manual import routine. 

For example, you may have daily updates of price data from your brokerage firm. You have created a folder on your 
computer where you store this data. You import it once into CandleScanner and then, periodically, update this folder with 
newer data. CandleScanner will detect the newer data. Use this option if you want to update the data periodically.  

Please note, that in order to use the automatic quotes update you need to keep the folder from which you imported the 
data on your drive. You also cannot change the name or location of this folder. 

3.3 Working with price chart 

3.3.1 Supported price chart types 

CandleScanner supports three types of price charts: 

 candlesticks chart (for more see Candlestick construction) 

 bar chart 

 line chart 

 You can switch between different types of chart using buttons located on the ribbon bar at HOME » Chart 
group. 

 

 

Figure 3.13. Switching between different chart types. 

 

Candlestick charts can be displayed in one of the four modes: 

 Classic. This is most widely used candlestick chart mode, in which down (black) candlesticks are coloured and up 
(white) candlesticks are empty. 

 CandleScanner. This mode is recommended for more advanced users. For more details, please read Candlestick 
charts: CandleScanner color theme. 

 Trend. This is similar to Classic mode (i.e. we have colored and empty candlesticks) but the candles have a 
different colour depending if they in an uptrend or a downtrend. 

 Custom. This mode allows a lot of customization by the user. 

All modes can be customized using Styles. 
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Figure 3.14. Buttons for switching between different candlestick chart mode. 

 

3.3.2 Using chart styles 

There are many characteristics on the chart area in CandleScanner which can be customized to meet your specific 
requirements. For example, you can change features such as: 

 size and color for all chart types, i.e. candlesticks, bar, and line 

 font size and color 

 background color 

 background details (interlaced or not, axes size, line type, and color) 

 

 

Figure 3.15. Style edition. 

 

CandleScanner allows managing chart styles which can be saved as themes. Users can create new and modify existing 
themes. There are also built-in themes, which can be used as templates for the new themes created by the user. Built-in 
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themes cannot be modified (i.e. when you modify anything within a built-in template you can only save it as a new theme). 
All built-in themes can be distinguished from user created themes as they have in their name (built-in) at the end. 

Users can easily change the current theme by clicking on the VIEW » Style » Style Edition button. When the theme is 
selected the change is immediately visible in the background, so the user does not have to go back and forth to see how 
the new theme looks in the application. 

When the user is editing the theme, most of the changes will be immediately visible in the background. Thanks to this the 
user does not have to save and close the edit window to see the changes. 

3.3.3 Chart zooming 

CandleScanner allows to increase or decrease the number of quotes (e.g. candlesticks in case of using candlestick chart) 
visible on the screen. To zoom-in use the button representing magnifying glass with plus sign in the bottom right corner 
of the application. To zoom-out use the button with a minus sign. 

 

 

Figure 3.16. Zooming buttons marked in the red rectangle. 
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4 Scanning candlestick patterns 

Candlestick patterns scanning functionality is the central and most important feature of CandleScanner. It allows you to 
find any candlestick pattern occurrences quickly on the chart. You can also adjust the scanning algorithms to meet your 
specific requirements. 

4.1 Supported candlestick patterns 

 

In CandleScanner, you can use Patterns Dictionary available from the HOME » New Window menu 

as a quick reference. From there you can navigate to the full patterns description located on our 

website. 

 

 

Figure 4.1. Patterns Dictionary document. 

 

CandleScanner recognizes in total 106 patterns: 20 basic candles and 86 candlestick patterns. The following list of authors 
and their books had the biggest influence on how the CandleScanner scanning algorithms were implemented: 

 Seiki Shimizu (The Japanese Chart of Charts) 

 Steve Nison (Japanese Candlestick Charting Techniques) 

 Thomas Bulkowski (Encyclopedia of Candlestick Charts) 
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 Greg Morris (Candlestick Charting Explained: Timeless Techniques for Trading Stock and Futures) 

 

The team responsible for developing CandleScanner has spent a considerable amount of time (spanning several years) on 
the analysis, on comparisons and on tests between what different authors had to say on the subject of candlesticks and 
candlestick patterns. It so happens, that even between well-known authors and their publications, there are differences, 
and even contradictions, on how to apply and interpret candlestick patterns. CandleScanner attempts to remain true to the 
spirit of the original Japanese formulation(s). Notwithstanding, rather than take and implement a rigid approach, the 
software also provides the opportunity for users to control various parameters. 

 

 

Figure 4.2. At our website, under the following link, http://www.candlescanner.com/patterns-dictionary/, you can find descriptions 

of candlestick patterns. Descriptions are enriched by a real-life examples and videos. You can also reach this via the Patterns 

Dictionary in CandleScanner. 

4.1.1 Basic candles 

Black Candle Gravestone Doji Short Black Candle 

Black Marubozu High Wave Short White Candle 

Black Spinning Top Long Black Candle White Candle 

Closing Black Marubozu Long White Candle White Marubozu 

http://www.candlescanner.com/patterns-dictionary/
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Closing White Marubozu Long-Legged Doji White Spinning Top 

Dragonfly Doji Opening Black Marubozu Doji 

Four-Price Doji Opening White Marubozu  

4.1.2 One-line patterns 

Bearish Belt Hold Hammer Southern Doji 

Bullish Belt Hold Hanging Man Takuri Line 

Gapping Down Doji Northern Doji Bullish Strong Line 

Gapping Up Doji One-Candle Shooting Star Bearish Strong Line 

4.1.3 Two-line patterns 

Bearish Doji Star Bullish Separating Lines Matching High 

Bearish Engulfing Bullish Tasuki Line Matching Low 

Bearish Harami Dark Cloud Cover On Neck 

Bearish Harami Cross Descending Hawk Piercing 

Bearish Meeting Lines Falling Window Rising Window 

Bearish Separating Lines Homing Pigeon Thrusting 

Bearish Tasuki Line In Neck Turn Down 

Bullish Doji Star Inverted Hammer Turn Up 

Bullish Engulfing Kicking Down/Bearish Kicking Tweezers Bottom 

Bullish Harami Kicking Up/Bullish Kicking Tweezers Top 

Bullish Harami Cross Last Engulfing Bottom Two Black Gapping Candles 

Bullish Meeting Lines Last Engulfing Top Two-Candle Shooting Star 

4.1.4 Three-line patterns 

Advance Block Downside Tasuki Gap Three Outside Up 

Bearish Abandoned Baby Evening Doji Star Three Stars in the South 

Bearish Side-by-Side White Lines Evening Star Three White Soldiers 

Bearish Tri Star Identical Three Crows Two Crows 

Bullish Abandoned Baby Morning Doji Star Unique Three-River Bottom 

Bullish Side-by-Side White Lines Morning Star Upside Gap Three Methods 

Bullish Tri Star Three Black Crows Upside Gap Two Crows 

Collapsing Doji Star Three Inside Down Upside Tasuki Gap 

Deliberation Three Inside Up  

Downside Gap Three Methods Three Outside Down  
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4.1.5 Four-line patterns 

Concealing Baby Swallow Bearish Three-Line Strike Bullish Three-Line Strike 

4.1.6 Five-line patterns 

Bearish Breakaway Ladder Bottom Rising Three Methods 

Bullish Breakaway Ladder Top  

Falling Three Methods Mat Hold  

 

 

Following patterns were discovered by the CandleScanner team during the development of the 

software: Turn Up, Turn Down, Bullish Strong Line, Bearish Strong Line, Bullish Tasuki 

Line and Bearish Tasuki Line. They are included in the list of supported patterns due to their 

good efficiency and high frequency, which makes them potentially attractive for traders. 

4.2 Displaying patterns on the chart 

Scanning for candlestick patterns in CandleScanner is automatic. This means that once you load data into CandleScanner 
and display the symbol on the price chart, you immediately see the found patterns for the specific symbol. The list of 
patterns is updated when you switch the time interval in which you are displaying the price chart. 

 

 

Importing data quotes into CandleScanner is described in chapter Importing data quotes 

into CandleScanner. 

4.2.1 List of identified patterns 

To open a price chart for a specific symbol either right-click on it and select Open in new window » Price Chart or 
click on the button Price Chart from the HOME » New Window menu. 

 

 

When the symbol is displayed in the price chart for the first time for a specific time interval, the 

load time is longer because CandleScanner is scanning patterns on the fly. The subsequent load 

time of the chart for this symbol will be faster as the scanning results are already saved. 

 

The resulting list of identified patterns is shown to the right of the chart. You can filter these by any column. For 
convenience, patterns are displayed on the list in different colors for bullish and bearish patterns (green and red by default). 
When any item is clicked on the list, the particular pattern is indicated on the chart with the name and an arrow. Location 
of the pattern label on the chart can be changed using mouse – simply click on the label and drag and drop it to the desired 
location. Name can be either a number, using the value from the # column where all patterns are listed, or the full name 
of the pattern. You can switch between them using buttons Number and Name from the VIEW » Pattern Label menu. 

Selection of more than one item from the pattern list is possible by holding the CTRL key down and selecting each pattern 
by left clicking the mouse. CandleScanner then indicates on the chart all of the selected pattern occurrences. Please note 
however that it can happen that not all occurrences can be visible on the chart if the period between first and last pattern 
is too long so that they cannot be seen on the screen without scrolling it. 
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When you click on an item from the list of found patterns and this particular pattern occurred in a period which is not 
currently visible on the chart, it will be automatically scrolled to enabling you see it unless VIEW » Synchronization » 

Chart With List option is not switched off. For more on this feature see section 4.2.2. 

 

 

Figure 4.3. List of identified patterns. 

4.2.2 Synchronization between the list of found patterns and the price chart 

CandleScanner provides the possibility to synchronize the list of found patterns with the price chart and vice versa. This 
means that you can, for example, scroll the list of found patterns, and the price chart will automatically scroll so that you 
can see the time periods on the chart. For this reason, the list of patterns is always sorted by the date of occurrence in 
ascending order. The reverse order of synchronization is also possible, i.e. you can scroll the price chart and the list of 
found patterns will also be scrolled, enabling you to see the patterns from that period which is displayed on the price chart. 

Synchronization can be switched on/off separately for price chart and pattern list via the ribbon bar using following 
checkboxes: Chart With List and List With Chart. Both checkboxes are available in the VIEW » Synchronization 
menu (see Figure 4.3). 

4.2.3 Highlighting patterns on the chart 

You can highlight pattern occurrences without clicking on the items on the list of found patterns. There are three options 
available on the ribbon bar from the VIEW » Pattern Highlighting menu:  

 Bullish 

Highlights all bullish patterns (both bullish reversal and bullish continuation). By default, patterns from this group 
are highlighted by a greenish background.  

 Bearish 

Highlights all bearish patterns (both bearish reversal and bearish continuation). By default, patterns from this 
group are highlighted by a reddish background.  



CANDLESCANNER USER’S GUIDE 48 

 

 

 Conflicting 

Highlights all conflicting patterns, i.e. the cases where bullish and bearish patterns occur at the same time. By 
default, such situations are indicated by a white background.  

 

 

Figure 4.4. The Pattern Highlighting and Style Edition. 

 

Every single group of patterns, i.e. bullish, bearish or conflicting can be highlighted by any other color. To modify this, 
please click Style Edition button from the VIEW » Style menu. 

When the mouse is hovered over the highlighted pattern, a tooltip is displayed with the full name of the pattern. 

4.3 Recent patterns 

The Recent Patterns document is designed for a regular scan of the symbols group to find latest patterns. For example, 
let assume that we are using daily charts, and the quotes data is also updated daily (please see the chapter about importing 
data into CandleScanner for more details). Once the data is updated the easiest way to see if any new patterns were formed 
is to use the Recent Patterns document. 

 

 

Note that when you are performing a scan for the same Group, Interval and Scanner 

Settings, it will be executed incrementally if some previous search results already exist. In other 

words, the application will only scan the quotes which were not yet scanned, which may 

significantly speed up the scanning operation. 
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Using the right scanner settings profile (Scanner Settings field in the New scan tab) may have 

a great impact on the search results. Performing the same scan, using a different scanner settings 

profile will most likely produce different search results. 

 

 

Figure 4.5. Recent Patterns functionality. 

 

To open a Recent Pattern document use the HOME » New Window » Recent Patterns button on the ribbon. A 
popup window will appear from which the user may perform two operations: 

 Perform a new scan (New scan tab) 

 Open an existing scan (Last scan tab) 

4.3.1 Performing a new scan 

You need to select a group of symbols which you would like to scan (Groups field). 

Then you need to specify a time interval of candlesticks you want to use for the scanning process (Interval field). For 
example when you have a group of Forex symbols saved in 5-minutes base intervals, you can perform a few scans on this 
group for different candlesticks periodicity, e.g. 5-minutes bars or hourly bars. 

In CandleScanner, you may have several scanner settings (Scanner Settings field). For example, you may have different 
scanner settings profile for 5-minutes forex bars and different for a daily S&P500 bars. Therefore, you need to specify the 
scanner settings to be used to perform the particular scan. 

Finally, you need to define for how many most recent candlestick bars you want to see search results (Scan Period field). 
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4.3.2 Opening an existing scan 

Depending on the number of the symbols within a symbols group, the scanning process may be quick or time-consuming. 
If you do not have a newer market data, but would like just to see patterns which were already found, you can opened 
previous scan results. 

4.3.3 Viewing the Recent Patterns search results 

Once the scanning process is finished, or you are opening an existing search result, a table is produced where all found 
patterns are contained. You may easily filter and sort them using the table column headers. 

Double-click on any row to open a new chart document to see a particular pattern occurrence. 

4.4 Scanner settings 

CandleScanner allows for the definition of more than one scanning profile. Only one profile can be used at a time, but the 
user can easily switch between profiles if needed. This can be helpful on certain occasions such as: 

 Different settings for different markets (e.g. stocks, currencies, commodities) 

 Different settings for different time intervals (e.g. 5-minute, hourly, daily) 

 Different personal preferences (e.g. a different setting for calculating the trend) 

Scanner settings are available at HOME » Scanner » Scanner Settings. All details are well described within the help 
panels on the settings window. You can create more than one settings profile and easily switch between them depending 
on your specific needs. 

 

 

Although scanner settings can be very powerful in terms of flexibility, please note that they should 

be reserved for advanced users who understand what they are doing. For less experienced users 

default settings should be enough. 

4.5 Practical recommendations on using CandleScanner 

In this section, we provide the users with some practical advice on how to use CandleScanner in the most effective way. 

4.5.1 Scanning only interesting patterns 

CandleScanner recognizes 86 candlestick patterns (excluding basic candles).  By default, CandleScanner uses all of them 
during the scanning process. You may, however, disable some patterns from the scanning process. To do so, please go to 
FILE » Settings » Candle Patterns. 

Please note that basic candles are always included in the scanning process, i.e. they cannot be disabled as can candlestick 
patterns. This is due to the fact that basic candles are the building blocks for other patterns and, therefore, always need to 
be active during scanning. 
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Figure 4.6. In this window, you can select candlestick patterns that should be included/excluded during the scanning process. 

 

4.5.2 Scanning speed and some performance recommendations 

Overall, CandleScanner is very efficient when it comes to the speed of its scanning algorithms. Performed tests show that 
on a computer with an Intel Core i7 @ 2.70 GHz processor, the application finds on average 3,700 patterns per second. 
Nevertheless, it is good to follow few simple recommendations when using CandleScanner in order to make the work 
more efficient.  

In general there are three main factors which have the biggest impact on the speed of CandleScanner: 

 Number of quotes per symbol in a given time interval (i.e. number of candlesticks per symbol on the chart) 

 Number of patterns which are looked for 

 Number of all symbols loaded into CandleScanner (across all symbol groups) 

 

 

The maximum number of candlesticks (quotes) for one symbol in CandleScanner cannot exceed 

500,000 (half million).  

Having, however, such large data sets is not recommended due to performance issues should all 

quotes be plotted on the chart or used for statistics calculations. Smaller data sets should be 

sufficient in most cases. For example, a data set containing 100,000 quotes is equivalent to some 

500 years of daily prices or 2 years of hourly prices. 

 

The currently used time interval is important as it comes to the speed of scanning. The factor which does not always matter 
is the total number of quotes (candlesticks in the base interval). For example, if there is a symbol with 500,000 1-minute 
quotes (base interval), displayed in a daily mode (c.a. 347 days in this case), it will be faster than the ten times smaller data 
set made up of 50,000 1-minute quotes (base interval) displayed in 1-minute mode (c.a. 34 days). Simply, in the first case, 
although the a data set consists of 500,000 quotes it is scanned as if there were only 347 quotes because it is presented in 
daily time intervals. 



CANDLESCANNER USER’S GUIDE 52 

 

 

 

 

The base time interval of the symbol is the minimal time interval which can be used for the given 

symbol. For example, having imported the quotes for EUR/USD symbol expressed in 15-minute 

time interval, allows one to plot the chart as a 15-minute chart, or any multiple of 15-minutes (e.g. 

30-minutes, hourly, daily). With the base time interval equal to 15-minutes, you cannot however 

plot the chart made of 20-minutes candlesticks. 

 

In order to speed up your scanning, you should store only the data set which is really needed and relevant to your trading. 
For example, if you are trading stocks using daily candlestick charts it is far better to use the data set with daily quotes 
rather than an intraday data set plotted to a daily chart. In this case, even a data set made up of 10,000 daily quotes allows 
the plotting of charts for the last 40-50 years, which is most probably even more than you need. Even so, such data sets 
are still relatively very small for CandleScanner, and can be quickly processed. 

Another factor which has an impact on scanning speed is the number of patterns which you are looking for. CandleScanner 
supports 86 patterns (excluding the basic candles). But, most probably, a greater number of them are not that interesting 
due to their very low frequency of occurrence and hence low statistical significance. It is recommended to exclude from 
scanning those patterns which are not interesting. As an example of a good filter for patterns to scan, you can use the 
following approach: 

1. Make sure that all patterns are included in scanning process (FILE » Settings » Candle Patterns). 
2. Calculate the statistics for the whole symbol group you are going to trade (make sure to specify the right time 

interval). 
3. Open the statistics and check the patterns frequency. Write down the 10 most frequent patterns as the most 

interesting (i.e. those having a higher statistical significance than the very rare patterns). 
4. Exclude the less frequent patterns from the scanning process using Options. 

From now on CandleScanner will be looking only for the 10 most frequent patterns, thus running significantly faster than 
when all 86 patterns are activated for the scanning process. Make sure, however, that this is undertaken at the individual 
symbol level as there can be considerable differences in pattern profiles. 
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5 Working with statistics 

 

Note that Symbols Group statistics module is not available in CandleScanner Basic edition (symbol 

statistics is available however). 

 

It’s not enough just to know that a pattern has occurred on the candlestick chart, but also how “well” or “badly” it had 
performed in the past. In other words, how effective is the signal being generated? 

And here, even before going into a heavy duty backtesting analysis, we can check some simple statistics first. As a first 
pass, there’s no need for detailed model optimization, no need for sophisticated entry/exit methodology and no need for 
risk and money management rules, just a basic analysis of the underlying statistics. What matters at this stage is: the number 
of accurate occurrences (how statistically significant the results are) and the price behavior within 5 or 10 subsequent 
candlesticks after the pattern’s occurrence. 

The most challenging aspect is to effectively convey the statistics and present them in such a way readily showing pattern 
efficiency, just after its occurrence. CandleScanner adopted very simple principle. If there is a bullish reversal or a bullish 
continuation pattern on the chart, the next 5 or 10 candles (depending on the user's preferences) should demonstrate its 
prognostic value. 

The efficiency of a pattern is measured by checking the maximum price (for bullish patterns) or minimum price (for bearish 
patterns) within test period. CandleScanner is using two periods: 5 or 10 candles following the pattern. Every period is 
producing a separate result. 

Stop Loss order is used to have more realistic results. If Stop Loss level is reached, the algorithm stops and the so far the 
most extreme price is used to calculate efficiency level. 

The user can set Stop Loss level, and ranges for FALSE, LOW, MEDIUM and HIGH efficiency. These settings may have 
a great impact on the efficiency readings. 

5.1 Algorithm assessing a pattern's efficiency 

 

Please note that scanner settings may have a great impact on the number of identified patterns 

and consequently on statistics. 

For example changing the maximum acceptable deviation of the maximum body height for doji 

candles may cause a major impact on the number of found patterns. It may happen, for 

instance, that a Hammer pattern will be identified as a doji candle and will be rejected. 

An even greater impact may have Statistics Calculation Settings. 

Therefore, it is recommended that any changes to the settings of the scanner are performed with 

a full understanding of possible consequences during the scanning process. 

 

The algorithm evaluating the efficiency of a bullish pattern occurrence works as follows: 

1. If Stop Loss price level is reached on the first candle following the pattern, the occurrence is marked as FALSE. 
2. Is Stop Loss price level is reached within test period, the highest price reached prior to Stop Loss is used to assign 

the pattern occurrence to appropriate efficiency level (i.e. FALSE, LOW, MEDIUM or HIGH). 
3. If Stop Loss price level is not reached within test period, the highest price reached during the full period is used 

to assign the pattern occurrence to appropriate efficiency level (i.e. FALSE, LOW, MEDIUM or HIGH). 

The algorithm for every pattern occurrence is run for the period of 5 and 10 candles, producing two separate results. 
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If there are not enough candles following pattern occurrence, the result is marked as NO DATA. 

The algorithm works the same for bearish patterns, except that instead of using the highest price reached during the test 
period, the lowest one is used. 

5.2 Symbol statistics 

Symbol statistics calculates, as the name implies, statistics related only to a specific symbol. This type of statistics should 
be used to have detailed information on the level of the given symbol. It is very important to know that the same pattern 
can behave totally different for different symbols/markets. 

To open symbol statistics click HOME » Symbol Statistics from the New Window buttons group on the ribbon bar. 

Symbol Statistics window is composed of tabs. Every tab presents statistics from a different perspective. 

Symbol statistics is composed of five tabs: 

 Patterns Occurrences 

 Patterns Efficiency (Chart) 

 Patterns Occurrences by Date 

 Basic Candles Occurrences 

 Report 

5.2.1 Patterns Occurrences 

In this tab you can see how many patterns' occurrences were detected by the application for a given symbol. On the left, 
there is a pie chart where every piece is reserved for a different pattern. When you click directly on the chart, an appropriate 
row from the list on the right will be selected. When any item from that list is clicked, then the appropriate pie chart piece 
will be enlarged. 

Please note that the occurrences can be filtered in many ways. For example, you may be interested to see only statistics for 
bullish patterns. To do so click on the funnel symbol in the Forecast column and set a required value. 

5.2.2 Patterns Efficiency (Chart) 

This tab presents efficiency of all patterns that were found for a specific symbol. For example, if the given symbol has 25 
occurrences of Bullish Engulfing pattern, all of them are grouped, and efficiency statistics is calculated for them. 

Efficiency can be seen using number or percentage values. To switch between these two options use the Unit drop-down 
list. It may be very important especially when overall occurrences number for a given pattern is fairly low. 

Additionally you may compare statistics measured for two different period length, that is 5 or 10 candles. To switch 
between these two options use the Testing period drop-down list. 

Please note that the efficiency statistics can be filtered in many ways. For example, you may be interested to see only 
statistics for bullish patterns. To do so click on the funnel symbol in the Forecast column and set a required value. 

5.2.3 Patterns Occurrences by Date 

In this tab, we can see all patterns occurrences for a given symbol, each displayed in a separate row. We can see for example 
how every single pattern occurrence performed. Two previous tabs (Patterns Occurrences and Patterns Efficiency (Chart)) 
are calculated based on this data. 

Please note that the table can be filtered in many ways. For example, you may be interested to see only bullish patterns. 
To do so click on the funnel symbol in the Forecast column and set a required value. 
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5.2.4 Basic Candles Occurrences 

In this tab you can see how many particular basic candles were detected by the application for a particular symbol. The 
tab uses the same approach as the Patterns Occurrences tab. 

5.2.5 Report 

Report tab is summarizing statistics for a given symbol. 

5.3 Group statistics 

Group Statistics calculates, as the name implies, statistics for the whole group of symbols. It allows one to look at a 
particular group of symbols from a broader perspective. 

Group Statistics is composed of six tabs: 

 Patterns Occurrences 

 Patterns Efficiency (Chart) 

 Patterns Efficiency (Details) 

 Basic Candles Occurrences 

 Symbols 

 Report 

5.3.1 Patterns Occurrences 

In this tab you can see how many patterns' occurrences were detected by the application for all symbols within a given 
group. On the left, there is a pie chart where every piece is reserved for a different pattern. When you click directly on the 
chart, an appropriate row from the list on the right will be selected. When any item from that list is clicked, then the 
appropriate pie chart piece will be enlarged. 

Please note that the occurrences can be filtered in many ways. For example, you may be interested to see only statistics for 
bullish patterns. To do so click on the funnel symbol in the Forecast column and set a required value. 

5.3.2 Patterns Efficiency (Chart) 

This tab presents efficiency of all patterns that were found within a group of symbols. For example, if the given symbols 
group has 25 occurrences of Bullish Engulfing pattern, all of them are grouped, and efficiency statistics is calculated for 
them. 

Efficiency can be seen using number or percentage values. To switch between these two options use the Unit drop-down 
list. It may be very important especially when overall occurrences number for a given pattern is fairly low. 

Additionally you may compare statistics measured for two different period length, that is 5 or 10 candles. To switch 
between these two options use the Testing period drop-down list. 

Please note that the efficiency statistics can be filtered in many ways. For example, you may be interested to see only 
statistics for bullish patterns. To do so click on the funnel symbol in the Forecast column and set a required value. 

5.3.3 Patterns Efficiency (Details) 

This tab presents how patterns efficiency is spread out among symbols and patterns. It may be useful for example when 
we want to see which patterns and for which symbols within the whole group are performing best. Alternatively using this 
tab we can eliminate the patterns and/or symbols which are not performing well. 

Every pattern and symbol are grouped into 4 rows block, presenting its efficiency. 
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5.3.4 Basic Candles Occurrences 

In this tab you can see how many particular basic candles were detected by the application among all symbols for a given 
group. The tab uses the same approach as the Patterns Occurrences tab. 

5.3.5 Symbols 

This tab lists all symbols within a group. It happens that not all symbols within a group contain an equal number of 
candlestick bars. Then it may be useful to see, for example, how many candles and within which period were scanned for 
each particular symbol. 

5.3.6 Report 

Report tab is summarizing statistics for a given group. 

5.4 Exporting statistics to external files 

Symbol and group statistics can be exported to external files in the following formats: 

 Microsoft Excel (.xslx) 

 ASCII text file (.csv) 

In order to export statistics make sure that statistics window is active in CandleScanner and the click on the ribbon DATA 

» Export » {Excel, Text}. For both formats, you can specify which parts of the statistics should be exported. Please 
note that export to Excel creates just a single file, whereas export to a text files creates multiple files. 
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6 Backtesting 

 

Note that backtesting module is not available in CandleScanner Basic edition. 

 

Once we know the patterns' occurrences and efficiency based on the statistics calculated by CandleScanner, we can go a 
step further. Specifically, we can backtest our trading ideas, using the entry and exit signals we found in the candle patterns. 
In other words, we can quickly replicate transactions using the identified candle patterns on historic data. The anticipation 
is that in conducting a test on past data, and arriving at encouraging results, this will repeat in the future. In other words, 
future performance will resemble past performance, based on similar patterns of candles. There are many aspects and 
issues which need to be considered when undertaking a thorough and realistic backtest. Here we provide a few basic ideas 
and an overview of some of the capabilities found in CandleScanner. 

CandleScanner allows the user to build a trading strategy without the necessity to write any code. Using a simple user 
interface you can define your entry signal (pattern) and exit signal (stop-loss, trailing-stop, and take-profit). All these 
building blocks are parameterized, i.e. you can adjust them, so they meet your requirements. 

You can also optimize your trading system, meaning you can define a range of parameters for different building blocks of 
your system, and CandleScanner will find the optimal values of those parameters. 

For example, you can define a minimum and maximum allowable value defining the width of the trailing-stop used in your 
trading system. You specify the step (increment) value which will be used by CandleScanner to calculate a set of parameters 
defining the width of the trailing stop. Every parameter value is then used by CandleScanner to perform a backtest. If 
more than one parameter is optimized, CandleScanner uses all possible combinations of parameter values, and, for every 
single combination, performs a backtest. At the end of the optimization process, CandleScanner presents the list of results 
which can be sorted or filtered, as required. 

Backtest results contain many metrics which can help you to see how your trading idea(s) performs. You can also export 
backtest results and process them, for example, in a spreadsheet or some more focused software dedicated to trading 
system analysis. 

Another nice feature of CandleScanner is that every single transaction from the backtest can be displayed on the chart, 
showing all the most important components such as entry point, stop-loss, and trailing-stop/take-profit. 

6.1 Backtester screen organization 

In order to open backtester screen click HOME » Tests button on the ribbon bar. New backtester window behaves 
differently than other window types (e.g. price chart window or statistics window). Namely the tool windows, i.e. groups, 
symbols and its properties are not visible. The reason for this is that groups and symbols can be selected within the 
backtester window directly. 

 

 

When test window is opened, group window, symbol window, and properties window cannot be 

visible. This is normal behavior. 

 

Backtest window is composed of three tabs: 

 Settings. In this screen, you can set all details for a test you want to perform. 

 General Results. High-level results from the backtesting. This is especially useful if during backtest 
parameter(s) optimization process was performed, and we want to see differences in performance between 
different parameters sets. 
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 Detailed Results. Detailed results for a specific set of parameters. We can track here every single transaction. 

 

 

Figure 6.1. Backtest module. 

 

You can create multiple test profiles via BACKTEST » Settings » Backtester Settings button on the ribbon. Every 
profile specifies exact entry and exit conditions which are used when tests are being performed. Each aspect of these 
settings is described directly on the screen. 

Test profile has a great impact on the output from the backtester. For example setting a very narrow Stop Loss level may 
cause that during simulation, trades will be closed too often on Stop Loss order generating losses. On the other hand using 
very wide Stop Loss may cause that losses will be too big to be compensated by profitable trades. 

To save your time, CandleScanner helps you to find optimal values for parameters used in exit/entry conditions. 

Typically depending on your expectations and markets you may need several testing profiles. 

6.2 Settings tab 

In this screen, you can initialize a backtest. Following details need to be specified: 

Test profile in the Current Settings field. To add/modify/delete profiles use the BACKTEST » Settings » Backtester 

Settings button on the ribbon. Test profile used during backtest has a great impact on the results. 

 Test period. You can either specify that a backtester should use All Available Quotes or a specific From/To 
dates. 

 Position. In CandleScanner, you can run backtest for one pattern at a time. Bullish patterns are opening long 
positions, whereas bearish counterparts are opening short positions. 
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 Symbols to be tested. Although you cannot perform tests where several patterns are used at a time, you may 
run one test for multiple symbols at one time. Click the Group list to select symbols group you want to test. 
Symbols contained in the group will be displayed in the Available symbols list automatically. At least one 
symbol has to be selected for testing (use <, <<, >>, > buttons to move symbols between Available symbols 
and Selected symbols). 

 Periodicity. Depending on the selected symbols group, you may specify the candlestick periodicity to be used 
during test. Every test may be performed at only one Interval at a time. 

When all above details are set accordingly to your needs, press Execute button to perform the test. Test results are 
presented in the subsequent tabs, that is General Results and Detailed Results. 

6.3 General Results tab 

Because in CandleScanner you may use many backtest parameters at one run, in this view you will find aggregated results 
for all parameters sets. Every symbol is presented in a single row. 

6.4 Detailed Results tab 

Detailed Results panel is divided into three panels: 

 Parameters. In this table, every symbol and parameter set is displayed in a single row. In other words, you can 
easily see how a particular parameters set works for a given symbol. 

 Trades list (by selected parameter). In this table, you can see all transactions and its details for a symbol 
and parameters set selected in the Parameters panel. 

 Transaction Chart. In this panel, you can see the transaction selected in the Trades list panel presented on the 
chart. 



CANDLESCANNER USER’S GUIDE 60 

 

 

7 Technical analysis 

Some traders combine Japanese candlestick patterns with technical analysis indicators. In this section, we present several 
technical indicators supported by CandleScanner together with a short description. This is not intended to be a detailed 
guide to the various indicators, which are covered by several excellent texts. 

There are two main groups here: 

 Technical overlays. Indicators from this group use the same scale as prices and, therefore, can be plotted on 
top of them. For example, in CandleScanner you plot a Simple Moving Average of close prices directly onto the 
candlestick chart. Moreover, you can then directly compare the two. 

 Technical indicators. Indicators from this group do not use the same scale as prices. For this reason, it's better 
to plot them in a separate chart, usually below the candle chart. For example, the RSI is an oscillating indicator 
ranging from 0 to 100. If this indicator was superimposed on the candlestick chart, for example on the EUR/USD 
FX rate, it would then "flatten" the candlestick pattern rendering it impossible to discern any patterns. 

 

 

Note that technical analysis indicators are not available in CandleScanner Basic edition. 

7.1 Working with technical analysis indicators on the chart 

CandleScanner can open up to three panels dedicated for technical analysis indicators  (called I1, I2, I3 respectively) 
within the chart area (document) at a time. The top panel is reserved for a price chart (it can be extended by a volume 
panel), the remaining three panels are available for the indicators and/or volume. It is up to the user which panels are 
visible and their content. 

On the first panel, where the price chart is located, you can put indicators which are from the technical overlays group (e.g. 
Simple Moving Average, SMA, of price). It is not possible to add on this panel other indicators to avoid problems with 
different scales (e.g. Average True Range, ATR). You can add more than one technical overlay at a time to this panel, however. 
For example, you can put Bollinger Bands, and two SMAs with different parameters.  

On the indicators panels (I1, I2, I3) you can put any indicator you wish, either technical overlays or technical indicators. Each 
indicators panel can be occupied by more than one indicator at a time only if they have a common scale. For example, you 
can put into panel I1 Stochastic %D and RSI because they share the same scale. You cannot add there however in that case 
ATR. 

Figure 7.1 shows all possible panels visible: 

 price panel (P) 

 volume panel (V) 

 first indicators panel (I1) 

 second indicators panel (I2) 

 third indicators panel (I3) 

Price panel is always visible (cannot be closed/hidden). Volume panel is only available when underlying symbol contains 
volume data. If this is the case panel can be visible or hidden. All three indicators panels can be visible at any time. Volume 
and indicators panels can be shown/hidden using the ribbon bar. 
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Figure 7.1. CandleScanner with all panels visible: price panel (always visible – cannot be hidden, labeled as P), volume panel – can be 

hidden from the ribbon via VIEW » Chart » Volume (labeled as V), 1-3 indicators panels which can be hidden via VIEW » 

Panels » {I1, I2, I3}. Please note that volume panel can be shown only if the underlying data contains volume quotes. 

7.1.1 Adding indicator to the chart 

Indicators can be added only from the ribbon bar using buttons from the HOME » Indicators group. Clicking on any 
button from this group expands the list of available indicators. When any item from this list is clicked, a popup window is 
opened in which indicator’s parameters can be set with its location on the screen. 

 

 

Figure 7.2. Indicators are split into three major functional groups. 
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Please note that every indicator has its list of parameters and can look differently. 

 

 

Figure 7.3. The typical window for adding/editing technical analysis indicator. On the figure, an example showing Stochastic %D 
indicator. 

7.1.2 Hiding indicators on the chart 

 

Figure 7.4. Hiding indicator on the panel (Hide item). Notice also Edit and Remove items. 
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If on the given panel there are more than one indicators, some of them can be hidden (without hiding the whole panel). 
To do it right-click on a given panel and select Hide item. To put it back use the Unhide option. 

 

 

Make sure that you are clicking on the right panel within chart document. Every panel is 

managed separately, therefore, if you want to hide the RSI from the second panel you need to 

right-click on this panel exactly to see it on the list under the Hide menu item. 

7.1.3 Removing indicators from the chart 

In order to remove an indicator from the chart panel right-click on it and select Remove (Figure 7.4). Then you will see 
the list of indicators which are currently on the chart. 

 

 

Make sure that you are clicking on the right panel within chart document. Every panel is 

managed separately, therefore if you want to remove RSI from the second panel you need to 

right-click on this panel exactly to see it on the list under the Remove menu item. 

7.1.4 Editing indicators 

In order to edit an indicator right-click on the panel where it is located and select Edit (Figure 7.4).  Then you will see 
the list of indicators which are currently on the given panel. After clicking on one of them, a popup window will appear 
where all parameters relevant to specific indicator can be modified. 

 

 

Make sure that you are clicking on the right panel within chart document. Every panel is 

managed separately, therefore if you want to remove RSI from the second panel you need to 

right-click on this panel exactly to see it on the list under the Edit menu item. 

7.2 Technical analysis indicators in CandleScanner 

This section lists and concisely describes technical analysis indicators available in CandleScanner. 

7.2.1 Average Directional Movement Index (ADX) 

The Average Directional Movement Index (ADX) is used to measure the strength of a trend. It is a so-called non-directional 
indicator, meaning that the strength of a trend is quantified regardless of its direction. 

In CandleScanner ADX is enriched by two other indicators: Plus Directional Indicator (+DI) and Minus Directional Indicator (-
DI). They define trend direction. When used together with ADX, traders can determine both the direction and the strength 
of a trend. 

ADX, +DI and -DI are plotted as three separate lines. 

 

Parameters 

 Period: number of candlesticks which are used to calculate the indicator 
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7.2.2 Average True Range (ATR) 

The Average True Range (ATR) is used to measure the volatility of the market. It is based on the True Range (TR) indicator, 
which in ATR is averaged and smoothed. It takes into account price gaps. 

ATR values are not comparable because its readings are higher for equities with higher prices and lower for ones with 
lower prices. In other words, ATR represents absolute price changes. 

 

Parameters 

 Period: the number of bars, or period, used to calculate the indicator 

7.2.3 Bollinger Bands 

The Bollinger Bands measures the market volatility. It is composed of a Simple Moving Average (SMA) and standard deviation, 
calculated on the prices. Below and above the SMA volatility bands are placed, calculated as some multiplier of a standard 
deviation. 

When the standard deviation increases, the bands are becoming wider and the opposite. 

The Bollinger Bands indicator uses the same scale as prices and, therefore, may be plotted on the price chart. 

 

Parameters 

 Price Field: defines the price (open, high, low or close) used to calculate the indicator (used both, for SMA and 
standard deviation calculation) 

 Period: the number of bars, or period, used to calculate the indicator (used both, for SMA and standard deviation 
calculation) 

 Width: standard deviation (SD) multiplier for the upper and lower bands 

7.2.4 Commodity Channel Index (CCI) 

The Commodity Channel Index (CCI) is a momentum oscillator that may be used to identify overbought/oversold levels or 
trend reversals. 

Evaluation of the CCI readings may be difficult because there are no upside and downside limits. 

CCI value increases when prices are above the average and the opposite. 

Typically the CCI is used with other technical analysis indicators. 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the indicator 

7.2.5 Chaikin Oscillator 

The Chaikin Oscillator is calculated by subtracting a slow Exponential Moving Average (EMA) from a fast EMA of the 
Accumulation/Distribution Line (ADL). In other words, it is an indicator of an indicator. 

 

Parameters: 

 Fast Average: the number of bars, or period, used to calculate the fast EMA 

 Slow Average: the number of bars, or period, used to calculate the fast EMA 
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7.2.6 Chaikin Money Flow (CMF) 

The Chaikin Money Flow (CMF) is an oscillator that fluctuates between -1 and +1. 

CMF measures bullish and bearish pressure for a given period of time. A move into positive region indicates buying 
pressure while a move into negative area indicates selling pressure. 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the indicator 

7.2.7 Exponential Moving Average (EMA) 

The Exponential Moving Average (EMA) assigns a weight to the price data as the average is calculated. Therefore, the oldest 
price data in the EMA is never removed (as it happens in the case of the Simple Moving Average for example), but they have 
only a minimal impact on the moving average value. By doing that, EMA reduces the lag by applying more weight to 
recent prices. 

 

Parameters: 

 Price Field: defines the price (open, high, low or close) used to calculate the indicator 

 Period: the number of bars, or period, used to calculate the indicator 

7.2.8 Moving Average Envelopes 

The Moving Average Envelopes are bands placed above and below a Simple Moving Average. 

Bands are percentage-based meaning that each envelope is set the same percentage above or below the moving average. 

The Moving Average Envelopes may be used to identify overbought and oversold levels and as a trend following indicator. 

 

 

Parameters: 

 Price Field: defines the price (open, high, low or close) used to calculate the indicator 

 Period: the number of bars, or period, used to calculate the indicator 

 Width%: percentage of the moving average, used to plot the upper and lower band 

7.2.9 Ease of Movement 

The Ease of Movement oscillator measures the relationship between volume and price changes.  The oscillator is useful for 
assessing the strength of a trend. When prices are increasing the Ease of Movement is in positive region and the opposite. 
The values of the oscillator fluctuate above and below the zero line. 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the indicator 

7.2.10 Moving Average Convergence / Divergence (MACD) 

The Moving Average Convergence / Divergence (MACD) oscillator subtracts the longer Exponential Moving Average (EMA) from 
the shorter EMA. This is called the MACD Line. On top of that an EMA of the MACD Line is plotted. 

The MACD values fluctuate above and below the zero line as the moving averages converge, cross and diverge. 
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The MACD oscillator brings together momentum and trend in one indicator. 

 

Parameters: 

 Fast Average: the number of bars, or period, used to calculate the fast average (EMA) 

 Slow Average: the number of bars, or period, used to calculate the slow average (EMA) 

 Signal Average: the number of bars, or period, used to calculate the EMA of the MACD Line 

7.2.11 Money Flow Index (MFI) 

The Money Flow Index (MFI) is an oscillator that is similar to the Relative Strength Index (RSI). Known as volume-weighted 
RSI. 

The MFI name comes from the fact that is measuring the strength of money flowing in and out of a security. 

Like the RSI, MFI values oscillate between 0 and 100. Typically, MFI value exceeding 80 is considered overbought and 
MFI below 20 is considered oversold. 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the MFI 

7.2.12 Rate of Change (ROC) 

The Rate-of-Change (ROC), also referred to as Momentum, is a momentum oscillator. There are other indicators measuring a 
momentum, but ROC is considered as the purest one. 

Indicator measures the percentage increase or decrease in price over a given period of time. It shows the speed at which 
prices are changing. 

 

Parameters: 

 Price Field: defines the price (open, high, low or close) used to calculate the indicator 

 Period: the number of bars, or period, used to calculate the indicator 

7.2.13 Relative Strength Index (RSI) 

The Relative Strength Index (RSI) is a momentum oscillator that measures the market's strength. RSI value above 70 means 
that the market is overbought. A low RSI value, that is below 30, indicates an oversold market. 

RSI values oscillate between 0 and 100. 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the RSI 

7.2.14 Simple Moving Average (SMA) 

The Simple Moving Average (SMA) smooths the price chart and filters out the market noise. It is a simple arithmetic mean 
of the previous n data points, for example, closing prices. 

SMA may be used to identify the direction of the trend or determine potential support and resistance areas. 

 

Parameters: 
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 Price Field: defines the price (open, high, low or close) used to calculate the indicator 

 Period: the number of bars, or period, used to calculate the SMA 

7.2.15 Stochastic Oscillator (%K and %D) 

The Stochastic Oscillator is composed of two indicators: %K and %D. The latter one is a Simple Moving Average (SMA) of 
the %K. 

Stochastic Oscillator is a momentum indicator following the speed (momentum) of price. 

 

Parameters: 

 %K 
- Period: the number of bars, or period, used to calculate the %K 

- %K Average  

 %D 
- Period: the number of bars, or period, used to calculate the %K 
- %K Average: SMA period for %K 

7.2.16 True Range (TR) 

The True Range is the greatest value of the following: 

 Current High less the current Low 

 Current High less the previous Close (absolute value) 

 Current Low less the previous Close (absolute value) 

 

Note that the first TR value is simply the High minus the Low. 

TR is used to calculate the Average True Range (ATR) indicator, measuring market volatility. 

A simple volatility formula based only on the high-low range does not reflect price gaps. TR is a more realistic indicator 
because includes the gaps into calculations. 

ATR is an average of TR values which is smoothened by incorporating the previous period's ATR value. 

In CandleScanner TR for n candlestick bars is calculated as a simple average of TR values. 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the average of TR values for a given period of time 

7.2.17 True Strength Index (TSI) 

The True Strength Index (TSI) is a momentum oscillator based on a double smoothing of price changes. It determines 
overbought and oversold conditions. 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the TSI 

7.2.18 Vortex Indicator (VTX)  

The Vortex Indicator (VTX) may be used to determine the beginning of a market trend and its strength. 
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Parameters: 

 Period: the number of bars, or period, used to calculate the VTX 

7.2.19 Weighted Moving Average (WMA) 

The Weighted Moving Average (WMA) assigns a weight to the price data as the average is calculated. In other words WMA 
assigns more importance to recent data what makes it more sensitive to price changes than, for example, the Simple Moving 
Average (SMA). 

 

Parameters: 

 Period: the number of bars, or period, used to calculate the indicator 
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